CAPITULO 2

SISTEMAS VECTORIAL Y RASTER

Como lo habiamos discutido anteriormente, los elementos geogréaficos en un territorio
pueden ser representados mediante formas geométricas simples, esto es puntos, lineas
y poligonos. Adicionalmente podemos agregar un modelo de representacion abstracta
del espacio, esto es, vectores o matrices (raster). En base a la postura anterior,
podemos definir a los SIG por la forma de representar el espacio en dos modelos o

formatos, el modelo vectorial y el raster.
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Figura 2.1.- Representacion de las entidades geogréficas del territorio (Mundo real)

mediante modelos numéricos y con entidades geométricas (Modelo Raster y Vector).

La eleccién de uno u otro modelo de representacion de nuestros objetivos y el tipo de
analisis a aplicar. En general la estructura de datos vectorial es la opcion mas usada
para hacer cartografia tematica, sin embargo su estructura de datos es mucho mas
compleja y este hecho hace que cualquier andlisis ocupe mucho tiempo en el PC
proceso. Por otra parte, si se desea realizar un analisis sobre datos espaciales
continuos. la mejor opciéon es el formato raster, que es mucho mas rapido en



cualquier proceso numérico por su estructura sencilla. Ambos formatos tienen

fortalezas y debilidades, de las cuales se muestra un resumen en la tabla siguiente.

Objetivo

Modelo Vectorial

Modelo Raster

Almacenamiento espacial

Coordenadas x,y para puntos,

lineas y poligonos

Celdas de igual tamano
ordenadas en filas y columnas
(Matrices)

del

objeto (Feature representation)

Representaciéon  espacial

Puntos
Lineas

Poligonos (4reas)

Puntos - celda
Lineas - conjunto de celdas

adyacentes con estructura
lineal.

Poligonos - conjunto de celdas
estructura

adyacentes  con

superficial.

Cartografia

Precisién, posicion.

No para fenémenos continuos.

Iméagenes, fendmenos continuos.

El Formato Raster

El formato raster se fundamenta en la divisién del drea de estudio en una matriz de

celdillas, generalmente cuadradas. Cada una de estas celdillas recibe un tnico valor

que se considera representativo para toda la superficie abarcada por la misma,

tradicionalmente llamada pixel (picture element). Este formato, por tanto, cubre la

totalidad del espacio, este hecho supone una ventaja fundamental ya que pueden

obtenerse valores de forma inmediata para cualquier punto del mismo.

La matriz numérica, puede contener tres tipos de datos:

e Valores numéricos en caso de que la variable representada sea cuantitativa.

¢ Identificadores numéricos en caso de que se trate de una variable cualitativa.

Estos identificadores se corresponden con etiquetas de texto que describen los

diferentes valores de la variable cualitativa, los cuales pueden encontrase

anexos en una base de datos.

* Identificadores numéricos tinicos para cada una de las entidades representadas

en caso de que la capa raster contenga entidades (puntos, lineas o poligonos)
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Figura 2.2.- Ejemplo de la estructura rater para representar datos continuos(a) y

discretos(b) mediante la asignacién de tablas de color.



La informacién geométrica de la estructura matricial del archivo viene anexa a los
datos, ya sea en un archivo separado o integrado a los datos espaciales. Normalmente
se debe contar con informaciéon de su posicion en el espacio y geometria de la matriz,

esto es:

* Numero de filas (nf)
* Numero de columnas (nc)
* Coordenadas de las esquinas de la matriz o capa raster (e, w, s, n)

* Resolucién o tamano de pixel en latitud y en longitud (ry, i)

Normalmente el ntmero de filas y columnas son constantes y el ntmero total de
elementos de matriz o pixeles (celdas) es la multiplicacién entre ambos valores. Es
bueno mencionar que las imagenes de satélite se ven afectadas por la curvatura de la

Tierra, efecto que hay que corregir y que veremos en otro capitulo.
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Figura 2.4.- La estructura matricial o raster presenta ventajas comparativas al

momento de representar o modelar variables ambientales continuas.



.1.0 Adicionalmente, y para que se pueda desplegar una capa raster en
0.20

la pantalla del computador es necesaria una tabla de colores
o (Paleta de colores), que relaciona los valores de pixel y el color a
018 representar o que se pintara cada celdilla en la pantalla (Ver figura
013 adjunta). En caso de que la variable sea cualitativa, la tabla de
010 asignaciéon de color que haga corresponder a cada identificador
0.08 numérico una etiqueta de texto descriptiva. A modo de ejemplo, la
0.06 figura 2.2 muestra la estructura raster para representar datos
003 continuos(a) y discretos(b) mediante la asignacion de tablas de
0.005 color.

Fortalezas y debilidades del modelo raster

Fortalezas

1.Es una estructura de datos simple.

2.Las operaciones de superposicion de mapas se implementan de forma mas rapida y
eficiente.

3.Cuando la variacién espacial de los datos es muy alta el formato raster es una
forma mas eficiente de representacién.

4.El formato raster es requerido para un eficiente tratamiento y realce de las

imagenes digitales.

Debilidades

1. La estructura de datos raster es menos compacta. Las técnicas de compresion de
datos pueden superar frecuentemente este problema.

2. Ciertas relaciones topoldgicas son mas dificiles de representar.

3. La salida de gréaficos resulta menos estética, ya que los limites entre zonas tienden
a presentar la apariencia de bloques en comparacion con las lineas suavizadas de los
mapas dibujados a mano. Esto puede solucionarse utilizando un nimero muy elevado
de celdas mas pequenas, pero entonces pueden resultar ficheros inaceptablemente
grandes.



El Formato Vectorial

Al contrario de lo que ocurre con el formato raster, el formato vectorial define
objetos geométricos (puntos, lineas y poligonos) mediante la codificacion explicita de
sus coordenadas. Los puntos se codifican en formato vectorial por un par de
coordenadas en el espacio, las lineas como una sucesion de puntos conectados y los
poligonos como lineas cerradas (formato orientado a objetos) o como un conjunto de
lineas que constituyen las diferentes fronteras del poligono (formato Arco/nodo).
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Figura 2.5.- Ejemplo de la representaciéon vectorial para puntos (a), lineas(b) y

poligonos(c).

Este formato resulta especialmente adecuado para la representaciéon de entidades
reales ubicadas en el espacio (carreteras, rios, parcelas de cultivo). También resulta

mas adecuado que el raster cuando se manejan datos que suponen un valor



promediado sobre una extension de territorio que se considera homogénea, los limites
de la misma pueden ser arbitrarios o no (por ejemplo estadisticas municipales,
profundidad de acuiferos, etc.).

El modelo vectorial Conceptualiza el espacio como una coleccién de objetos discretos,
los cuales pueden ser representados espacialmente por entidades cartograficas
(puntos, lineas o poligonos) y descritos por un conjunto de propiedades (atributos).
En el formato vectorial, ademéas de codificar la posiciéon de las entidades, necesitamos
establecer las relaciones topologicas entre las mismas, especialmente en lo que se

refiere a los mapas de poligonos.

El término topologia hace referencia, en el contexto de los SIG vectoriales, a

relaciones entre los diferentes objetos para originar entidades de orden superior.
* Los nodos de dos lineas en contacto deben tener las mismas coordenadas.

* Un poligono se define, en el modelo arco-nodo, como un circuito perfecto de
lineas que puede recorrerse entero empezando y terminando en el mismo

punto sin pasar dos veces por la misma linea.

* Existe un solo identificador para cada entidad y este es tinico, no se repite en

ninguna otra entidad.

* Se dispone de algin modo de codificar los poligonos isla. Se trata de los
poligonos completamente rodeados por otro poligono debiéndose informar al
poligono contenedor de la existencia del poligono isla para tenerlo en cuenta al

calcular su area.

Una base de datos cartografica digital habitualmente estd conformada por varios
mapas tematicos de una misma area geografica. Dependiendo de su naturaleza y de
la escala de trabajo, los objetos geograficos podran ser representados por puntos
lineas o poligonos en la cartografia. Cada tipo de entidad se representa en una mapa
distinto o capa especifica (Layer). Ejemplo de una representacién de puntos, lineas y
poligonos es mostrada en la figura 2.5.
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Figura 2.6.- Ejemplo de modelacién vectorial para el caso de un tranque en una

localidad especifica.

La figura anterior muestra un ejemplo de aplicacion del modelo vectorial para

representar cartograficamente un objeto geografico. En la parte superior derecha se

observa una imagen satelital de un area cualquiera, resaltando una zona dedicada a

almacenar agua por medio de un tranque. Los elementos geogréficos relevantes que

ahi aparecen son digitalizados, como son el caso de los limites del tranque y un

camino que pasa por su entorno. En el caso del tranque este es representado por un

poligono, el camino representado por una linea y la ubicaciéon de la compuerta para

liberar el agua por un punto. Adicionalmente podrian haber otras estructuras que

también, previo a un analisis, deben

Streets

Land Use
Administrative Areas
Hydrography
Elevation

Imagery

ser representadas por puntos, lineas y poligonos.

En un SIG las capas tematicas son
representaciones légicas 'y en entidades
separadas. Cada entidad corresponde a una
capa de informaciéon, con sus formas y
ubicaciones geograficas, ademas de informacién
descriptiva sobre cada entidad o atributos los
cuales se encuentran asociados por medio de
una base de datos. La figura adjunta muestra
un ejemplo de este concepto.

La organizacién de la informacién espacial en capas geograficas se ha masificado y

ahora es el método mas empleado en los SIG para el manejo 16gico de la informacion,



de tal forma que este arreglo constituye la base de cémo los SIG representan,

utilizan, administran y aplican la informacion geografica.

Asociada a la componente grafica o espacial, se encuentra una componente no
espacial. Se trata de tablas o bases de datos que representan los distintos atributos
asociados al elemento geografico representado en la cartografia, esto es cada entidad
presente en el mapa tiene asociado un registro en una tabla (Figura 28). La tabla
asociada puede tener datos de distinta naturaleza, como niumeros, textos o fechas,

entre algunos, como se muestra en la tabla siguiente.

Numérico 245 3.16879  12.34E(+5)
Caracteres (String) | 'mombres" "45" "#$%&7?;"
Boleano '"Falso" "Verdadero'

Fecha 12/07/2010 07-12-2010

Los valores numéricos en una base de datos pueden ser

Byte : para enteros comprendidos entre 0 y 255. El requisito de almacenamiento es 1
byte.

Entero : para enteros comprendidos entre -32.768 y 32.767. El requisito de
almacenamiento es 2 bytes.

Entero largo : para enteros comprendidos entre -2.147.483.648 y 2.147.483.647. El
requisito de almacenamiento es 4 bytes.

Simple : para valores numéricos de punto flotante comprendidos entre -3,4 x 1038 y
3,4 x 1038 de hasta siete digitos significativos. El requisito de almacenamiento es 4
bytes.

Doble : para valores numéricos de punto flotante comprendidos entre -1,797 x
10308 y 1,797 x 10308 de hasta quince digitos significativos. El requisito de
almacenamiento es 8 bytes.

Id. de réplica : para almacenar un identificador tinico global necesario para la
réplica. El requisito de almacenamiento es 16 bytes. Observe que la réplica no se
admite con el formato de archivo .accdb.

Decimal : para valores numéricos comprendidos entre -9,999... x 1027 u 9,999... x

1027. El requisito de almacenamiento es 12 bytes.
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Figura 28.- Asociada a los elementos gréaficos presentes en la cartografia se encuentra
una base de datos que contiene los atributos de cada elemento.
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Figura 2.9.- La estructura vectorial presenta ventajas comparativas al momento de
representar o modelar variables ambientales discretas.



La base de datos asociada al archivo vectorial se encuentra regida por los modelos de
bases de datos relacional. Ademas se cuenta con un sistema de enlace de informacion
contenida en tablas separadas que permite facilitar la busqueda en bases de datos

complejas o muy extensas.
Fortalezas y debilidades del modelo vectorial
Fortalezas

1. Genera una estructura de datos mas compacta que el modelo raster.

2. Genera una codificacién eficiente de la topologia y, consecuentemente, una
implementacion maéas eficiente de las operaciones que requieren informacién
topoldgica, como el analisis de redes.

3. El modelo vectorial es mas adecuado para generar salidas graficas que se

aproximan mucho a los mapas dibujados a mano.

Debilidades

1. Es una estructura de datos mas compleja que el modelo raster.

2. Las operaciones de superposicién de mapas son mas dificiles de implementar.

3. Resulta poco eficiente cuando la variacién espacial de los datos es muy alta.

4. El tratamiento y realce de las imagenes digitales no puede ser realizado de manera
eficiente en el formato vectorial.

Sistema de Gestién de Base de Datos (SGBD)

Un SGBD permite el almacenamiento, manipulaciéon y consulta de datos
pertenecientes a una base de datos organizada en uno o varios ficheros. En el modelo
més extendido (base de datos relacional) la base de datos consiste, de cara al usuario,
en un conjunto de tablas entre las que se establecen relaciones. A pesar de sus
semejanzas (ambos manejan conjuntos de tablas) existen una serie de diferencias
fundamentales entre un SGBD y un programa de hoja de calculo.

El método de almacenamiento y el programa que gestiona los datos (servidor) son
independientes del programa desde el que se lanzan las consultas (cliente). En lugar
de primarse la visualizacion de toda la informacién, el objetivo fundamental es



permitir consultas complejas, cuya resolucion esta optimizada, expresadas mediante
un lenguaje formal. El almacenamiento de los datos se hace de forma eficiente
aunque oculta para el usuario y normalmente tiene, al contrario de lo que ocurre con
las hojas de calculo, poco que ver con la estructura con la que los datos se presentan

al usuario.
Base de El acceso concurrente de multiples usuarios
Datos X . .
autorizados a los datos, realizando operaciones
1 de actualizaciéon y consulta de los mismos
Programa . .
/ cliente garantizando la ausencia de problemas de
y seguridad (debidos a accesos no autorizados) o
Programa : : S E :
gervidor s/ Programa integridad (pérdida de datos por el intento de
e Bases — | cli . . . .
de Datos cliente varios usuarios de acceder al mismo fichero al
\ mismo tiempo. La figura anexa muestra un
\ Programa esquema sobre el método cliente-servidor en
cliente una base de datos

Bases de datos relacionales

Es el modelo més utilizado hoy en dia. Una base de datos relacional es basicamente
un conjunto de tablas, similares a las tablas de una hoja de célculo, formadas por
filas (registros) y columnas (campos). Los registros representan cada uno de los
objetos descritos en la tabla y los campos los atributos (variables de cualquier tipo)
de los objetos. En el modelo relacional de base de datos, las tablas comparten algin
campo entre ellas. Estos campos compartidos van a servir para establecer relaciones
entre las tablas que permitan consultas complejas.

En la figura 2.11 se muestra una archivo de poligonos el cual se encuentra
relacionado con tres tablas, que tienen informaciéon de un municipio ficticio. Este tipo
de configuracion en las bases de datos permite una mejora en la obtencién de datos.
Por ejemplo, esta figura muestra una hipotética organizaciéon de los datos de su
comuna, donde se relacionan todas las actividades del municipio, tanto
administrativas como financieras. En el recuadro inferior se muestra una consulta
realizada por un funcionario de esta Municipalidad, donde consulta sobre empleados
puntuales, por ejemplo por su RUT(DNI) el cual se encuentra asociado a otros datos

como puesto, antigiiledad, sueldo, etc.
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Figura 2.11.- Ejemplo de la asociacion elementos graficos y una base de datos

relacional.
Bases de datos objeto-relacionales

La idea es mantener el esquema de tablas entre las que se establecen relaciones pero
permitiendo como atributos tipos mas complejos, denominados tipos abstractos de
datos (ADT) que admiten objetos geométricos. Deben poder definirse nuevos tipos de
datos que permitan almacenar la geometria (puntos, lineas, poligonos, etc.).

Las funciones y operadores ya existentes se adaptan a estos datos espaciales y se
opera con un lenguaje apropiado. El lenguaje SQL se extiende para manipular datos
espaciales, incluyendo funciones como distancia, cruce de lineas, punto en poligono,
etc., que se vieron el tema dedicado al formato vectorial. En el nivel fisico, es decir

en el modelo y archivo digital, se realizan cambios profundos.
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Figura 2.12.- Diagrama conceptual de una geodatabase.

Concepto de Geodatabase

El concepto de Geodatabase es uno de los conceptos que han experimentado en los
ultimos anos una mayor expansion en el mundo de los SIG. Se trata simplemente de
una base de datos que almacena toda la informacién relativa a un conjunto de
entidades espaciales (geometria, topologia, identificadores, datos teméticos, etc.).
Posibilidad de usar SQL, una versiéon ampliada de SQL en realidad, para hacer
consultas y andlisis sobre mapas vectoriales. Mayor integraciéon, en una sola
herramienta, de todas las funciones para trabajar con informacion vectorial. En
términos simples, se trata de un lugar o contenedor de los datos espaciales y sus
atributos. El concepto de Geodatabase hace referencia al hecho de que todos los
datos SIG (Archivos gréficos y bases de datos) son almacenados en una ubicacién

especifica para un facil acceso, manejo y administracién de ellos (Ver Figura 2.12).

"El modelo de almacenamiento de la geodatabase estd basado en una serie de simple
aunque esencial de conceptos de bases de datos relacionales y aprovecha los puntos
fuertes del sistema de administraciéon de base de datos (DBMS) subyacente. Las
tablas simples y los tipos de atributos bien definidos se utilizan para almacenar los
datos de esquema, regla, base y atributos espaciales de cada dataset geografico. Este
enfoque proporciona un modelo formal para el almacenamiento y trabajo con los
datos. A través de este enfoque, el lenguaje estructurado de consultas (SQL), una
serie de funciones relacionales y operadores, se puede utilizar para crear, modificar y
consultar tablas y sus elementos de datos"(ESRI).



Es posible comentar varias ventajas y desventajas de la utilizacion de una

Geodatabase. Entre las ventajas podemos mencionar:

a) Gestion de Datos Centralizada: Debido a que todos los datos de una Geodatabase
son almacenados directamente en sistemas gestores de bases de datos, todo lo
desarrollado en un proyecto es almacenado en un repositorio comun, tunico y
centralizado. Esta caracteristica facilita notablemente la administracion de los datos
y todos los procesos.

b) Edicién multiusuario: El método de geodatabase permite la edicién multiusuario y
el seguimiento de cambios en los datos, lo que significa que los usuarios pueden
acceder a los mismos datos simultadneamente.

c) Implementacién de comportamiento: Permite trabajar con elementos mads
intuitivos, lo que implica que los usuarios pueden aplicar sofisticadas reglas y
relaciones entre los datos, lo que conlleva a mas eficiencia en el ingreso y la edicion
de los datos. La orientaciéon a objetos se maneja adecuadamente definiendo los
dominios de los campos, valores por defecto, rangos de validacién, implementaciéon y

reglas.

d) Modelado de relaciones espaciales complejas: La Geodatabase incorpora tipos de
datos geograficos distintos, lo que genera una maximizacién de su potencial de uso en

cuanto a las herramientas del SIG.

e) Integracién a otros sistemas informaticos: El método permite la integracién de los
datos con otros sistemas informéaticos.

La principal desventaja de una Geodatabase es el manejo de multiusuario que es un
problema complejo, en cuanto a sus posibilidades o permisos y las necesidades de los

mismos.

2.1.- Analisis vectorial en SIG

Los actuales sistemas de informacion geograficas poseen una capacidad analitica que
se ha venido incrementando a medida de que mejoran los computadores y los
métodos y técnicas numéricas. Actualmente se pueden realizar procesos estadisticos

complejos, pero ademas andlisis espacial complejo donde los algoritmos operan



indistintamente con las base de datos grafica y relacional. En andlisis espacial, sin
embargo, es un concepto muy amplio y engloba un conjunto de técnicas y métodos
complejos. Su dominio va del simple analisis descriptivo de los datos hasta los mas
complejos analisis numéricos que nos podamos imaginar. Este parte del capitulo
tratara de develar algunos de los analisis mas ttiles y presentar los inicios del analisis
espacial de datos vectoriales.

2.1.1.- Consultas y buiisqueda espacial y tematica

Todos los SIGs poseen herramientas de busqueda, despliegue y consulta de datos
geograficos y ArcGis no es la excepcion. En efecto, ArcGis 9.3 posee una serie de
aplicaciones (software especifico) agrupadas en mddulos especificos(conjunto
integrado de aplicaciones) que le confieren su particularidad. El programa ArcGis
Desktop estd configurado como un sistema avanzado de aplicaciones y como una
estructura modular, vision de ESRI para un SIG. Los mdédulos son: ArcView,
ArcEditor y ArcInfo. ArcGis se encuentra organizado en tres productos escenciales:
ArcMap, ArcCatalog y ArcToolbox, los cuales los revisaremos a continuacion.

ArcMap: Es el componente primario de este sistema modular y es la

aplicacion de entrada. El objetivo de este modulo es el despliegue de
informacién, gestion de informacién como efectuar consultas, crear mapas
de alta calidad grafica, desarrollo de aplicaciones y todo tipo de
operaciones matematicas y geométricas sobre los datos.

éj ArcCatalog: Esta aplicacion proporciona herramientas para organizar y

mccasales  administrar varios tipos de informacion geogréafica de ArcGIS Desktop.
Entre los tipos de informacion que se pueden organizar y administrar
estan: geodatabases, archivos raster, mapas, geoprocesamiento, modelos y
comandos Python, entre algunos. Este médulo organiza los contenidos en
una vista de arbol que mejoran el trabajo sobre los datos ya que permite
seleccionar un elemento, ver sus propiedades y acceder a las herramientas
con las que realizar operaciones especificas.

& ArcToolbox: Es el moédulo que posee en forma organizada las
herramientas de geoprocesamiento. También es posible que estas pueden
manejarse también desde ArcCatalog. La ventana de ArcToolbox contiene

cajas de herramientas, que a su vez contienen herramientas y juegos de



herramientas. Por lo general cada herramienta posee un menu de ayuda

para facilitar el aprendizaje y la operatibilidad en la aplicacion de la misma

a datos geograficos.

Cuadro 1.1.- Descripcion de algunas extensiones encontradas en ArcGis Desktop.

Extension ArcGis

Descripcion breve

3D Analyst

Proporciona herramientas para la visualizacién en tres dimensiones, andlisis y la
generacion de superficies. También proporciona herramientas para el modelado
tridimensional y andlisis, como andlisis de cuenca visual y la linea de visién, altura de

punto de interpolacion, perfiles, determinacién de caminos, y el contorno.

ArcScan Proporciona herramientas y comandos que le permiten tomar imagenes digitalizadas o
escaneadas de mapas y convertirlos en capas de entidades basadas en vectores, tales como
shapefiles y geodatabases.

ArcPress Impresién avanzada de mapas.

Data Interoperatibility

Aplicacién para el manejo de multiples formatos de datos espaciales. (la estructura interna
de un archivo que permite el uso de la computadora). Estos formatos se presentan en dos

variedades: ArcGIS nativo y no nativo de ArcGIS.

Geostatistical Analyst

Extensién creada para el modelado avanzado de superficies mediante métodos
deterministas y geoestadisticos. Las capas rasters generados por esta extension pueden ser
utilizados posteriormente utilizando otras extensiones de ArcGIS como ArcGIS Spatial
Analyst y ArcGIS 3D Analyst.

Image Server

Permite administrar y procesar grandes volimenes de datos raster y proporciona acceso a
toda la empresa dentro de los SIG, CAD, imagenes y aplicaciones Web.

Maplex Esta extensién ermite controlar como las etiquetas se deben colocar en relacién con las
funciones, cémo las etiquetas pueden ser modificadas o reducidas para permitir una mayor
colocacion de la etiqueta cuando se restringe el espacio disponible, y cémo se resuelven los
conflictos entre las etiquetas cuando el espacio disponible es limitado.

MrSID Creacién y compresién de mosaicos de imagenes.

Network Analyst

La extension ArcGIS Network Analyst permite generar un dataset de red y realizar los

analisis en un dataset de red.

ArcGIS Publisher

Esta extension ofrece la capacidad de compartir y distribuir sus mapas y datos GIS
facilmente. Convierte ArcMap (. Mxd) y ArcGlobe (.3 dd) documentos en el formato de
mapa publicado (. Pmf) se utiliza con ArcReader. Los mapas publicados de ArcMap son
dos dimensiones (2D), mientras que los publicados de ArcGlobe son tres dimensiones

(3D).

Schematics

Permite visualizar la red representaciones geograficas y esquemética en el mismo entorno.
Esta extension se compone de potentes herramientas que permiten generar de forma
automadtica, visualizar y manipular la representacién grafica de la red utilizando la

informacion de base de datos.

Spatial Analyst

Esta extensién roporciona una amplia gama de modelos espaciales y funciones de anélisis.
Puede crear, consultar, mapear y analizar datos raster basados en células, realizar analisis
raster/vector integrado; derivar nueva informacién procedente de los datos existentes,
informacion de consulta a través de multiples capas de informacién, e integrar plenamente

los datos raster basados en células con las fuentes de datos vectoriales tradicionales .

Survey Analys/Survey Editor

Es una aplicacién que le permite almacenar y trabajar con las mediciones topograficas de
terreno. Ademds, Editor permite mejorar la precision de otras capas GIS utilizando

ubicaciones de los puntos definidos por las observaciones de campo.

Tracking Analyst

Es la extensién de objetos de asignacién que se mueven o cambian de estado a través del
tiempo. Consiste en un conjunto de herramientas para cargar, visualizar y analizar

informacién espacio-temporal.
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Copyright ©1993-2008 ESRI Inc. All Rights Reserved . .
o o Analyst, Schematics, Tracking Analyst. El cuadro
Provides tools for suface modeling and 3D visualization
1.1 muestra una lista de algunas extensiones
ot Stensons | e || disponibles para ArcGis Desktop. Adicionalmente

han sido desarrolladas otras extensiones ain mas
especificas, como Solar Analyst para la estimaciéon
de la radiacion solar, o ArcSwat para el
modelamiento hidrologico, entre algunas. La figura
adjunta muestra la ventana de activacién de
extensiones ubicada en Tools -> Extensions de la
barra de menta de ArcMap.

2.1.2.- Edicion de elementos vectoriales y atributos

La interfaz grafica de ArcMap es bastante intuitiva y al ir a Inicio->Programas->
ArcGis->ArcMap, o desde el icono en el escritorio en Windows, se despliega la

siguiente ventana.
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Tabla de contenidos

Figura 2.14.- Interfaz grafica de ArcMap.

Si deseamos ver una cobertura o archivo shapefile, que es el formato nativo de

. . + .
archivos vectoriales de ArcMap, debemos usar el boton Add (), para quitar una
cobertura se usa el botéon Remove ( ), ambos se encuentran en la barra de

menus.

Figura 2.15.- Ejemplo del despliegue de datos en ArcMap.

Cuando se agregan muchas cobertura la tabla de contenidos los muestra uno a uno, y
si el usuario lo desea puede realizar varias opciones sobre el despliegue de los mismos.
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Por ello el objetivo de la tabla de contenidos es
mostrar las coberturas activas por el usuario junto a
sus respectivas leyendas. Esta barra es movible y
también puede quedar estatica en un lugar, que por
defecto es el lado izquierdo de la ventana activa de
ArcMap. Si Usted observa con cuidado la tabla de
contenidos estd compuesta por 3 pestanas, esto es
Display, que se muestra por defecto, Source y
Selection.

La pestana Display muestra todas las coberturas
con las cuales el usuario esta trabajando, donde el
orden de aparicion es por defecto por el orden de
adicién, sin embargo es posible después darle el
orden necesitado. Con el boton derecho sobre cada
cobertura se despliega un menu de coberturas, que
veremos mas adelante.

La pestana Source muestra las coberturas asociadas
con su carpeta contenedora. Ademdas muestra los

archivos de datos no espaciales como las tablas.

La pestana Selection muestra en una forma distinta el listado de datos

seleccionados o coberturas.

ArcMap posee una barra de Menus llamada "main menu" donde se encuentran todas

las opciones y funciones del programa.

File Edit View Bookmarks Insert Selection Tools Window Help

Bajo este mentu se encuentra una barra de opciones basicas, donde a partir de iconos

se puede acceder a algunas funciones. Por defecto la barra estandar es la siguiente

LSdE/sB@x |~ Y| EIMEEE R




View
’_ Data View

L]
Layout View

Zoom Data

Zoom Layout

[~ status Bar
Overflow Annotation

E Scrollbars
BE Rulers
|>Y- Guides
Grid

Data Frame Properties...

4 |T Main Menu

|T 3D Analyst
Advanced Editing
Animation
Annotation
ArcPad
ArcScan
COGO
Cadastral Editor
Data Frame Tools
Dimensioning
Distributed Geodatabase

|7 Draw

|T Editor

Effects
GPS
Geocoding
Geodatabase History
Geometric Metwork Editing
Georeferencing

|7 Geostatistical Analyst
Graphics
Labeling
Layout
Map Cache
Network Analyst

Parcel Construction

-

Es posible ir agregando barras de herramientas al
meni del programa por medio de View->
Toolbars en la barra principal, segin lo muestra
la figura de la izquierda. Hay que tener en
cuenta que varias de ellas necesitan tener activas
algunas extensiones para poder ser adicionadas
en la barra de mentus activa.

Una de las barras més activada por los usuarios

es Tools, mostrada a continuacion.
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Dentro de las opciones de esta barra encontramos

&
o

Zoom In y Out centrado en un sector especifico.

-
£

L)
K

Zoom In y Out centrado en la vista actual.

Movimiento del mapa hasta una zona determinada(Pan).

Muestra toda la extension de las coberturas activas o Full Extent.

2

Zoom anterior o posterior (Prev - Next)

L

Selecciona y deselecciona elementos espaciales (Select Features)

Seleccion de elementos (Select Elements)

Informacién de un elemento contenido en la tabla de datos asociada(Identify).

Bisqueda de datos en la tabla (Find).

@3@7%"3

=
]

Permite marcar un punto alguna coordenada (Go to XY).

Permite conocer distancia y area mediante la digitalizacién en pantalla(Measure).

Wy

Permite ejecucion de hperlink.
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Show of type: IDmasas and Layers (*lyr)

Si adicionamos diferentes coberturas con

Add () y buscamos las opciones
adecuadas en la tabla de contenidos,
estas se aplican en la ventana de vista de
La
muestra la ventana que se despliega al

datos especiales. figura adjunta
momento de hacer un click en Add. A
partir de esa ventana se buscan los
archivos que se utilizardn en las carpetas

de su disco duro.

La tabla de contenidos y la vista de datos espaciales se vera como lo muestra la

figura siguiente.
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Figura 2.16.- Despliegue de datos geograficos en ArcMap.
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*rmn  Normalmente al cargar una cobertura ArcMap selecciona en

P » forma aleatoria los colores con los que se van a desplegar los
ﬁblw»mrw } elementos espaciales. Con el botén derecho del mouse uno accede
5:“" _ aun ment de las coberturas, donde se puede remover(Remove)
g el archivo solo desde la vista de datos o consultar la tabla de
fgiv:é;fﬁ;ilm atributos (Atribute Table). Estos ments contextuales son un
f::m;m » submeni de las aplicaciones asociadas y depende de donde se
o realiza el click con el botén derecho del mouse, esto en la tabla de

contenidos o la vista de datos (Figura 2.17).
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(a) 5“ Convert Features to Graphics... Distribute 4 (d)
“F Conyert Graphics To Features. .. Rotate or Fiip 4
Activate Properties. ..
Properties... (
c)

(b)
Figura 2.17.- Subments de Coberturas(a), Layers(b), Layout(c) y Data View(d).

Para modificar los colores de los elementos desplegados en la Vista de Datos, debe
realizarse un click sobre el nombre de la cobertura o sobre la leyenda de la misma.
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Figura 2.18.- Ventanas de los menis Layer Properties y Symbol Selector.

El ment Layer Properties tiene las siguientes funciones asociadas para el cambio
del despliegue de la informacion

General: Define la forma como se muestra el mapa mediante el uso de escalas.
Source: Define la referencia fisica del archivo.

Selection: Cambia la forma de mostrar los datos seleccionados en la Vista de Datos.
Symbology: Herramienta para seleccionar los simbolos y colores para el despliegue
de los datos. Escoger cuales campos o atributos se desean mostrar, cambiar el modo
de visualizar los datos para cada campo numérico.

Labels: Definir la forma de mostrar las etiquetas(Labels) de la cobertura

Definition Query: Seleccion de los datos a visualizar.

Joins&Relates: Definir cuales tablas o datos se pueden relacionar a una cobertura
particular.
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Figura 2.19.- Ejemplo de la aplicacién del meni Layer Properties para cambiar la
visualizacion en la Vista de Datos de las curvas de nivel de la Region de O'Higgins.

Magnifier: Es una herramienta que despliega una ventana de efecto lupa que
permite ver con mas detalles los elementos desplegados en la Vista de Datos. Esta
opcién se encuentra disponible en la barra de meni Window->Magnifier.
Haciendo click con el botén derecho del mouse sobre la barra de titulo es posible
cambiar las propiedades (Properties). La ventana se arrastra sobre la Vista de datos
para cambiar la zona del despliegue a visualizar.

Figura 2.20.- Herramienta Magnifier que permite observar con mas detalle los
elementos espaciales.



Overview: La herramienta Overview es muy impotante cuando se esta trabajando
con archivos muy extensos y se ha usado el Zoom In en muchas oportunidades y se
pierde la nocion de ubicacién en el area geografica de trabajo por parte del usuario.
Esta herramienta muestra en una pequena ventana la ubicaciéon del Zoom de trabajo
en una visiéon general del Layer, como se muestra en la figura 2.21. En la ventana
Layers Overview se puede mover el rectangulo achurado en rojo (Drag) y se puede
cambiar la zona de observacién detallada. La activacion de esta herramienta esta en

la barra de meni Window->Overview. Cuando se realiza Zoom es posible volver a

tener toda el area que cubre la cobertura con el icono O.

S
&%

zona donde se ha realizado el zoom en el layer.

Bookmark: Es un marcador espacial que sirve para delimitar o definir un area de
interés para su uso posterior. Se accede a esta herramienta en el menu principal como
Bookmark->Create, luego se despliega una ventana para dar un nombre

apropiado al area de interés

Spatial Bookmark |

Bookmark Mame: IAreaInteresCordiIlem|

OK Cancel
| |

Se recomienda haber definido el &area de interés previamente y tenerla ubicada
realizando el zoom en el area escogida. Para poder acceder a esta Area de Interés



posteriormente ir a Bookmark en el menu principal y elegir el nombre del area de

interés que aparece en el nuevo ment que se desplego.
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o ez . . 7
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barra de menis Tools. La opcién
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calculo.
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Figura 2.22.- Ventana Measure para medir distancia y areas.

Identify: Es una herramienta para consulta e identificaciéon de elementos espaciales.

Por lo general muestra los atributos tematicos en una ventana con caracteristicas de

una tabla. Para activar el comando, se realiza un click en la barra de ment en el



botén & y después se hace un click sobre el elemento que se desea consultar en la
Vista de Datos, el resultado se muestra en la figura 2.23.

i Identify 21|
oo, [ -
- limites Location: | 315,506,510 6,196,576.089 Unknown Un =/

~- 0617

Field [ value |
FID )

Shape Palygon

LcoD 06117

PROVINCIA | 1

DESCRIP  Quinta de Tikoco

REGION 6

AREA 85555070,433
SUPERFICIE | 8555.507

Figura 2.23.- Consulta de valor de atributo en una archivo de poligono usando la

herramienta Identify.

Seleccion de elementos espaciales: Seleccionar y deseleccionar elementos

espaciales (@El EI) se realiza para realizar alguna operacion. Por ejemplo borrar,
mover o copiar ese elemento. Los elementos seleccionados aparecen resaltados en la
Vista de Datos y en la tabla de atributos simultaneamente.
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Figura 2.24.- Seleccion de elementos de una cobertura.



El usuario debe definir, si lo desea, cudles de las coberturas activas del mapa son
posibles de ser seleccionadas y cuales no debe ser afectadas. Esta herramienta se
encuentra en el menu Selection->Set Selectable Layers, donde se despliega la

siguiente ventana para activar o desactivar los layers que seran seleccionables.

[N Set Selectable Layers ed e
5

Choose which layers can have their features selected interactively with the
Select Features tool, the Select By Graphics command, the Edit tool, etc.

centros_poblados Select Al |
curvas
ciudades Clear Al |

limites

Close |

4

Figura 2.24.- Herramienta Set Selectable Layers.
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" Each layer's primary display field Cancel |
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Atributos de los Elementos Espaciales: Los elementos espaciales poseen
atributos temaéaticos los cuales se encuentran almacenados en una tabla que se
encuentra relacionada con el archivo grafico en cada cobertura. La figura 2.25
muestra como ejemplo una tabla de datos para una region de Chile y que contiene
datos de las distintas caracteristicas de los suelos. Las tablas de atributos también

pueden estar asociadas o relacionadas a otras tablas mediante un campo comun.

Las tablas se componen de filas y columnas, donde las filas corresponden a los
atributos, los cuales estan asociados con la capa de informacién mediante un
identificador. Las columnas corresponden a los campos o los distintos tipos de
informacién descriptiva, la cual puede ser numérica, de texto(String) o de fecha
(Date).



Sl ArcMap permite la manipulaciéon de los dato al interior de
B Select By Attributes... o oo ) )
B glear selecton una tabla, permitiendo anadir, borrar registros, pero ademaés
Switch Selection . . .

et crear y borrar campos. La figura de la izquierda muestra el
Add Fieid... ment de opciones (Options) que se activa en la barra
Turn All Fields On . . .

PR inferior de la tabla de atributos. En ella se muestran las
Restore Default Column Widths opciones ya mencionadas anteriormente junto a una serie de
Joins and Relates » . .z
et ey , opciones nuevas con las que se puede hacer gestion de la

ated Tables

47 Create Graph... base de datos de atributos.

Add Tabl .z . . s .

- MT:C::La”“t También si hay una seleccién previa de algunos elementos,

&3 oa he

& . es posible solo desplegar estos valores (Show) en la opcion
e e Selected en la barra inferior de la tabla, en caso contrario
Export...

Appearance. .. usar All

10l
FID | Shape | FIRST_SIMB SERIE REGION ‘ORDEN CLASE_TEXT PROF | DAP | ARENA | LIMO | ARCILLA | CDC | PMP | CORG Moﬂ
3 0 |Polygon |A ARIDOS

1|Polygon [ACH ACHIBUEND 7 Inceptisol franco 115 16 383 45.03 [19.66 2532 (127 |085 166

2 |Polygon |AER AERODROMO

3|Polygon [AGD AGUA DEL GATO 13-5 Molisol franco arcillo limo 35 8.89 24.44 |16.67 17.32 1321|097  |188

4 |Polygon |AGF AGUA FRIA 9 Inceptisol franco limoso 100 085 |25.59 3869 357 364 2248 197 |335

5 |Polygon | AIT AITUI 10 Andisol franco limoso 110 054 509 346 568 43.87 (4021 |72 122

6 |Polygon | AJL AJIAL 6 Inceptisol franco arcillo aren 105 47.88 312 2091 19.67 |11.86 1 189

7 |Polygon |ALC ALERCE 10 Andisol franco 86 055 |76.93 2121|186 45.88 (31.52 [5.55 544
8|Polygon |ALH ALMAHUE 6 Vertisol arcilloso 120 3292 5468 |0 39.33 278 (115 188

9 |Polygon |ALT ASOCIACION ALTO COLORADO 76 Alfisol franco arcillo aren 85 22.61 762 [19.68 022 037
10 [Polygon |ANL ANILEHUE 98 Molisol franco limoso 140 17.64 2735 (501 1476|713 |053  |0.81
11 |Polygon |ANT ANTUCO 3 Andisol franco arenoso 75 157 |91.05 2.31 064 782 [364 |0.84 1.42
12 [Polygen |ANV ANTIVERD & Moliisol franco arenoso muy 100 49.07 343  |1683 21.38 [11.49 |0.91 179
13 [Polygen | AP TERRAZAS ALUVIALES RIO ALLIPEN

14 |Polygon | ARC ARAUCANO 9 Ultisol franco arcilloso 110 103 1424 2192 |63.83 28.71 (20.33 [1.19 203
15 |Polygon | ARN ARENALES 8 Entisol arenoso 150 157 |88.78 121 0 385 |24 022 038
16 |Polygon |ART ARTIFICIO 5 Moliisol arcillo limoso 85 14.08 4791 |38.01 3278 |2064 (181 329
17 [Polygon |ATL ANTIHUALA 8 Uttisol franco arcillo lima 140 087 |17.82 26.02 [55.94 38.22 |28.88 078 |1.33
18 [Polygon |ATN ALANTARA & Inceptisol franco arcillo lima 130 8.36 4412 [46.52 40.28 |25.29 |1.44 |246
19 [Polygon |ATO CORTE ALTO 10 Andisol franco arcillo limo 194 082 |56.17 3091|1282 56.41 |26.64 132 |224
20 |Polygon [AYN ARRAYAN il Andisol franco limoso 140 05  |10.88 75.02 [15.35 60.27 (36.47 |427 |T.31
21|Polygen [AYT AYTUE 78 Alfisol franco limoso 110 10.18 22.89 [16.93 |1 53 [11.88 083 [1.09
22 |Polygon (BAA BARROS ARANA 9 Andisol franco limoso 40 074 2804 4776|2416 |ES 5 (3628 |613 104«

[l [ o

P.Eoord:ﬂj 1 jﬂ Show: W Selected Records (0 out of 571 Selected) Options =

Figura 2.25.- Tabla que contiene los atributos tematicos de los elementos espaciales.

Los formatos de tablas que puede manejar ArcMap son

* Geodatabase: Personal, por medio de MSAccess, o Compartida por medio de
Oracle, MS SQL, y otras RDMNS.

* Coverage: Es el formato nativo para guardar informaciéon tabular para
coberturas Arclnfo(Info).



* Shapefile: Formato Dbf, que es un formato antiguo DBase y es utilizado en
los archivos tipo Shapefile para guardar los atributos de los elementos
geograficos.

El software ArcGis puede ademds asociar tablas con otros formatos diferentes y
también realizar transformaciones entre distintos formatos, pero limitado. Las bases
de datos deben ser eficientes y faciles de manejar por los usuarios. Generalmente esta
es disenada con anticipacién a la entrada de datos en la misma. Se recomienda
escoger el tipo de datos adecuado para representar a los elementos geograficos,

eliminandose todo dato repetido en la tabla.
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Figura 2.26.- Ejemplo del manejo de tablas en bases de datos.

La base de datos creada puede ser relacional (RDBMS), esto es se encuantra
relacionada con otras tablas de forma légica(cardinalidad). Las relaciones pueden ser

del tipo

* Relacion uno a uno: Es el tipo de relacion mas comin y que mas
eficientemente maneja ArcMap. En este caso, el tipo de relacién ocurre
cuando un registro en la tabla le corresponde un tnico registro en otra tabla.



* Relacion uno a muchos y viceversa: Este es uno de los casos mas frecuentes,
pero no es manejado con facilidad por ArcMap. En este caso, el tipo de
relaciéon ocurre cuando un registro en una tabla le corresponden dos o maés
registros asociados en otra(s) tabla(s).

* Relacion muchos a muchos: No es una estructura muy comun y por lo general
es las relaciones entre los registros son complejas.

Las tablas se asocian entre ellas utilizando campos especiales con valores tinicos en la
tabla que comunmente se llama tabla principal. Estos campos son usualmente
llamados primary key (para la tabla principal) y foreign key (para las tablas
asociadas). En ArgMap existen herramientas para manejar las tablas, como unir
tablas y asociacion de ellas.

. , .
- E""“ Join: Es usado para conectar fisicamente dos
. Remove
Open Attrbute Table tablas. Puede unir tablas con cardinalidad 1
Joins and Relates i
i a 1 o muchos a 1. Los campos tienen que ser
@ Zoom To Layer Remave Join(s) 4
G e del mismo tipo de datos.
Visible Scale Range » Remove Relate(s)  »
Use Symbol Levels ]
— ; Relate: Permite definir relaciones entre
Label Features tablas en cuya cardinalidad es uno a muchos

Come e oo o muchos a muchos. Las tablas se
5? Convert Features to Graphics... . . .
Convert Symbology to Representation... mantienen independientes, esto es, las tablas
i . no quedan unidas fisicamente.
Save As Layer File...
Properties...

ArcMap posee una herramienta muy interesante, esta consiste en la confeccion de
graficoa partir de la informacion contenida en los campos de las tablas. Esta
aplicacién que se encuentra en el ment Options de la barra inferior de la tabla de
atributos con el nombre Create Graph. En las opciones del tipo de grafico permite
realizar de barras, de lineas, de area, de torta (Pie), Box plot y diagramas de
dispersion (scatter plot). La figura 2.27 muestra un ejemplo de la aplicacién de la
herramienta Create Graph para realizar un grafico de barras.
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Figura 2.27.- La herramienta Create Graph dentro del menti Options de la tabla de

atributos permite realizar grafico.

Para anadir un campo se debe ir al mend Options ubicado en la barra inferior de la

tabla de atributos y seleccionar Add Field, segin se muestra en la figura siguiente.

Parra borrar el campo basta realizar un click con el botén derecho de mouse y

aparece un pequeno menu donde estd la opcion Delete Field.

#% Find &Replace...
2 select By Attributes. .
D Clear Selecton
Switch Selection
Select All

Turn All Fields On
v  Show Field Aliases

Restore Default Column Widths

Joins and Relates »
Related Tables »
.m Create Graph...

Add Table to Layout
C Reload Cache
& print...

Reports 3
Export...

Appearance...

MName: ||
Type: IShort Integer j
r— Field Properties
|Precision [o |
o | cancel |

Figura 2.28.- Herramienta Add para crear campos en la tabla de atributos a partir

del menu Options.




Noétese en la figura 2.28 el hecho de que hay que tener claridad sobre el tipo de
registro (Type) y las propiedades del campo. Los tipos de registros que son admitidos
en la creacion de un nuevo campo son Short Integer, Long Integer, Float, Double,

Text, Date. Las diferentes opciones se describen a continuacion

Name: nombre o identificacién del campo (hasta 10 caracteres)
Type: tipo de datos que pueden introducirse en un campo. Los tipos son:

Short Integer: nimeros enteros (entre -32.000 y 32.000 aprox.)

Long Integer: ntiimeros enteros(entre -2 y 2 billones aprox.)

Float: Numeros decimales (hasta 7 digitos aprox.)

Double: Numeros decimales(hasta 15 digitos aprox.)

Text: Texto

Date: Fecha
Precision: longitud del campo. En los tipos float y double la precisién debe tener en
cuenta el nimero total de digitos incluida la coma decimal. La escala indica
el nimero de decimales. Por ejemplo para almacenar el ntimero 9.5 tenemos que
definir una precision de 3 y una escala de 1

Scale: Ntumero de decimales a usar.

El cuadro siguiente muestra los tipos de datos numéricos soportados en ArcMap.

Tipo Datos Rango Almacenamiento Tamaiio(Bytes) | Aplicaciones

Short Integer -32768 hasta 32767 2 Nuimeros enteros

Long Integer -2147438648 hasta 2147483647 4 Nimeros enteros de mayor rango
Float -3,4x10™* hasta 1,2x10" 4 Nimeros reales.
Double -2,2x107%% hasta 1,8x10"3%% 8 Niimeros reales de mayor escala.

El cuadro siguiente muestra la precision y escala sugerida para unos ejemplos
relacionados con los tipos de datos numéricos soportados en ArcMap y mostrados en
la tabla anterior.

Rango Tipo Datos Precision Scale
0a +99 Short Integer 2 0
-99 a +99 Short Integer 3 0
0 a +99.999 Long Integer 5 0
-99.999 a +99.999 Long Integer 6 0
0,001 a 0,999 Float 4 3
1.000,00 a 9.999,99 Float 6 2
-123.456,78 a 0 Double 9 2
0 a 1.234,56789 Double 9 5




Cuando se agrega(Add) un campo en la tabla de atributos, este puede ser ingresado
manualmente o calculado. Para realizar el calculo se hace un click con el botén
derecho del mouse sobre el nombre del campo y se depliega el menu mostrado en la
figura 2.29, y al aplicar Field Calculator, se despliega la ventana con la aplicacion.

= sort ascendng 21
F  sortDescending Fields: Type: Functions:
.;Q - FID 4 &
%] Advanced Sorting... FIRST_SIMB Number
SERIE " string
Summarize. .. REGION
ORDEN " Date
2. Statistics... CLASE_TEXT
= PROF
=} Eield Calculator... i:gu
LIMO
Calculate Geometry. .. ARCILLA
e x|
Turn Field Off BORRAR = [~ Advanced
Freeze fUnfreeze Column B
¥ Delete Field
Properties...
4] of;
I | Galeulate selected rerords only
Cancel

Figura 2.29.- Herramienta Field Calculator para el ingreso de campos nuevos en la
tabla de atributos.

Como ejemplo si queremos estimar una variable cualquiera a partir de la base de

datos, la formula que debemos introducir debe ser del tipo
BORRAR=[DAP] * [PROF] *( [CDC]- [PMP])/100

Para seleccionar las variables para insertarlas en la ecuacién basta hacer doble click

con el botén izquierdo del mouse.

- También en el mismo menu mostrado en la

Poperty: [ -
Coordnate System figura 2.29, se puede ingresar a Calculate
& Use coordinate system of the data source:

[PCS: WGS 1564 UM Zone 155 Geometry. Esta herramienta permite el
" Use coordinate system of the data frame: , . , 4

[FES: WeS 1933 v Zore 165 calculo del centroide, area y el perimetro en el
e ——— - caso de poligonos. En el caso de puntos
2] W grabara las coordenadas de los mismos en una




En el caso de una cobertura de lineas es posible tener nuevos campos con la longitud

de cada una, la coordenada de inicio y de fin, y la coordenada del centroide.

Operaciones logicas y matematicas

a‘ Analysis Tools

=&

Extract
- }a Clip
P Select
- }a split

g Table Select

= & Qverlay

g Erase
g Tdentity
- Intersect
#* Spatial Join
#* Symmetrical Difference
Union
#* Update

= % Proximity

}a Buffer

}‘ Create Thiessen Palygons
P Generate Near Table
-2 Multiple Ring Buffer

P Near

- Point Distance

=-§ statistics

A Frequency
#* Summary Statistics

(A AND B) OR C (AANDB) OR C

ANOTB

La mayoria de las opciones para el calculo y aplicacion de
funciones matematicas se encuentra en ArcToolBoox->Analysis
Tools o también en las opciones de la tabla de atributos.

Al lado izquierdo se muestran las herramientas que trae Analysis
Tools: Extraccion de datos, Superposiciéon de datos y coberturas,
Analisis de Vecindad y Estadistica.

Operaciones Loégicas: Con los archivos vectoriales es
posible emplear el algebra clasica ( >, <, = ) y élgebra de
Boole (A unién B, A no B, A interseccion B, ni A ni B).

El general este tipo de comandos y funciones son posibles de
encontrar en muchos SIGs, en especial en ArcGis. La opcién
para acceder a este tipo de procesos, se encuentra en

i % Select By Location. ..
“ Select By Graphics

@ Zoom To Selected Features
@ Pan To Selected Features
Z! Statistics..

Set Selectable Layers. ..

& Clear Selected Features

Interactive Selection Method — p

Options...

Layer: e
Method:  [Create a new selection =l
FID -]
"LCOD"
"PROVINCIA"
"DESCRIP"
"REGION"
"AREA" =l
= <> Like
> >= And
< <= Or
_|% O Not
ls Get Unigue Values |Gc To I
SELECT * FROM limites WHERE:
|
|

Clear | ety | Help I Load | Save... |

ok | ey | cese |




Operaciones Matematicas: Todos los SIGs
comerciales y de cédigo abierto incluyen programas
a partir de los cuales estan implementadas las
funciones basicas: suma, resta, multiplicacion,
division, raices cuadradas y razones

trigonométricas, entre algunos. Estas opciones de

funciones matematicas pueden ser de gran utilidad

para diferentes aplicaciones.

Operaciones Estadisticas: los programas permiten tratar nuestra tabla de
atributos mediante calculo de medias, varianzas, desviaciones tipicas etc. También es

posible observar la distribucién de nuestros datos mediante histogramas.

Operaciones Geométricas: Calculos de distancias, &reas, volimenes vy
orientaciones son basicos en este tipo de software dedicado al analisis espacial. De
nada sirve presentar mapas de colores y formas optimas, si desconozco las superficies
o distancias entre los distintos simbolos del mismo. Para el calculo de algunos
parametros geométricos se puede usar el meni Options de la barra inferior de la
tabla de atributos. El Area(Area) y el perimetro(Perimeter) de un poligono irregular
vienen dados por

A=LS (X =X 1Y) 2.)

i=1

P= i\/(xi - Xi+1)2 +( i _Yi+l)2 (2.2)

i=1

2.1.3.- Anélisis de vecindad y proximidad: Corredores y areas de influencia

" P Buffer Para muchas aplicaciones en GIS se requieren realizar analisis

Create Thi Fol . . .
ﬁG';ae,am',j;fr}a;:g""s de proximidad. Supongamos que un urbanista desea conocer la

?;:::"'em"gs“ﬂ%' distancia a los diferentes barrios para ubicar un parque y que

#* Point Distance

todos los barrios se ubiquen a una distancia minima. En este
caso un analisis de proximidad determinaria cuales lugares en
una capa de informacién estan o se encuentran localizados a una
distancia especifica de un cierto lugar definido con anterioridad.



Buffer: Crea poligonos de
O amortiguamiento a una distancia
especificada por las Entidades de entrada.
E Un opcional de disolver se puede realizar
para  eliminar  buffers  superpuestas.
ArcToolBox -> Analysis Toos-
INPUT OUTPUT >Proximity->Buffer.

o e
_ /’;j 4
fnna de Alio Riesgo

Figura 2.30.- Aéreas de influencia aplicada en cartografia.

Poligonos de Thiessen o Voronoi: Los poligonos de Thiessen (1911) es un
método de interpolaciéon simple nombrado asi en honor al meteordlogo
estadounidense Alfred H. Thiessen, y basicamente son una construccion geométrica
que permite realizar una particion del plano euclideo en un area delimitada. Estos
objetos también fueron ademas estudiados por el matematico ruso Georgy Voronoi, y
debido a esto también se denominan poligonos o diagramas de Voronoi y por el
matematico Gustav Lejeune Dirichlet, de donde se denominan teselacion de
Dirichlet. Este método fue desarrollado originalmente para estimar la precipitacion
espacial ya que su aplicacién es simple y entrega resultados satisfactorios. Este tipo
de método se ha aplicado a datos cuantitativos y cualitativos, sin embargo se cree
mas apropiado cuando los datos son cualitativos.



La forma de crearlos es unir los puntos entre
si, trazando las mediatrices de los segmento
de uniéon. Las intersecciones de estas
mediatrices determinan una serie de poligonos
en un espacio bidimensional alrededor de un
conjunto de puntos de control, de manera que
el perimetro de los poligonos generados sea
equidistante a los puntos vecinos 'y

designando su area de influencia. La figura

adjunta muestra un ejemplo de la
construccion de los poligonos.
El método de los poligonos de Thiessen es usado para delimitar areas de influencia a
partir del conjunto de puntos utilizados. El tamano y la configuracion de los
poligonos depende de la distribucién de los puntos originales. Una de las limitantes
del método es estimar el error asociado, ya que el valor asociado al poligono
corresponde a un solo punto.

Figura 2.31.- Los poligonos de Thiessen pueden ser utilizados para calcular la

precipitacion media de una cuenca hidrografica.

Los poligonos de Thiessen son utilizados para calcular la precipitacion media de una
cuenca, ya que ellos relacionan la precipitacion medida en cada punto y su area de
influencia dada por los poligonos de Thiessen. Desde un punto de vista cuantitativo,
la superficie de cada poligono se utiliza como si esta fuese el area de influencia de la
estacion meteorolégica que midié precipitacion, y que se encuentra localizada al



interior de un poligono. El drea de cada uno de estos poligonos (A;) debe ser
calculada para poder realizar el cdlculo de la precipitacién media de la cuenca

mediante la expresion:

iR A (2.3)
p =1

> A

Cuéando este céalculo se limita a una cuenca especifica, es probable que algunos datos
de estaciones queden fuera de la cuenca, sin embargo la cuenca contenga poligonos
asociados a estas estaciones limitrofes y que quedaron fuera. Lo que se hace
normalmente es estos casos es que se asigna el valor de la estacion limitrofe mas
cerca al poligono para realizar el calculo y solo se considera esa area interior a la
cuenca. Para el calculo de los poligonos de Thiessen es necesario ir a ArcToolBox -
> Analysis Toos->Proximity->Create Thiessen Polygons.

Point Distance: Esta  herramienta

=101
. T E e determina la distancia entre las entidades
1 .
S0 2|1 & de puntos en las Entidades de entrada a
OUTPUT TABLE
todos los puntos en el Cercano
* INPUT FEATURES Caracteristicas dentro del radio de
* NEAR FEATURES
btisqueda.

2.1.4.- Reclasificacién, Disolucién

El software ArcMap posee varias opciones para resumir o clasificar datos numéricos
ubicado en Proporties > Symbology > Quantities > Classify. Las opciones de
clasificacion en el despliegue de los datos son muy tutiles para una representaciéon mas
adecuada de la cartografia final. Las opciones para la clasificacién son varias, esto es
Manual, Intervalos iguales, Intervalos definidos, Cuantiles, Natural Breaks(Jenks),
Intervalo Geométrico, Desviaciéon Estandar. En algunas opciones es posible elegir
ademas el numero de clases que se desea obtener finalmente.
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Figura 2.32.- Opciones para clasificaciéon en el despliegue de los datos Proporties >

Symbology > Quantities > Classify.

INPUT

Dissolve (Disolver): Es un proceso de
agregacion en el que una nueva funcion de
la fusién de

mapa se crea mediante

ouTPUT poligonos adyacentes, lineas, o regiones que
tienen un valor comun para un atributo
especificado. Dissolve es una de las
herramientas de gestiéon de datos utilizados
para las caracteristicas de generalizar y
combina caracteristicas similares basadas

en un atributo o atributos especificados.

2.1.5.- Fusion, Superposicion, Union e interseccion

ﬁﬁa -Du'erlay

----- Erase

----- A Tdentity
----- ]" Intersect

----- A Spatial Join

----- # Union
----- #* Update

----- #* Symmetrical Difference

Superponer u overlay es una herramienta basica de
cualquier GIS la cual es utilizada para la integracion de
datos. El objetivo de esta herramienta es la superposicion
de diferentes coberturas de temas especificos, y de esta
forma generar nuevas coberturas, que contienen
informacién de cada una de las coberturas iniciales. Estas
superposiciones  pueden ser realizadas  utilizando
operaciones ldogicas y/o matematicas. En el caso de
ArcMap, esta se encuentra en ArcToolBox en Analysis

Tools.



Entre las opciones de Overlay encontramos Erase, Identify, Intersect, Spatial Join,

Symetrical Difference, Union y Update. Sin embargo Analysis Tools posee aun mas

herramientas de andlisis sobre coberturas, como las mostradas a continuacién.

&y Statistics
- 7+ Frequency

#* Create Thiessen Polygons g Summary Statistics
#* Generate Near Table
-2 Multiple Ring Buffer

}“ Mear

...... A% Point Distance

Discutiremos a continuacion las mas usadas en los diferentes procesos de analisis en

ArcMap.

INPUT

OUTPUT

-

\
g

Union: Genera una interseccion
geométrica entre coberturas. Todas las
entradas deben ser de un tipo de geometria
comun y la salida sera del mismo tipo de
geometria. Esto significa que un ntimero de
clases de elemento de poligono y capas de
entidades se puede unir. Las caracteristicas
de salida tendran los atributos de los

archivos de entrada que se superponen.

Merge (Append): Es una funcién de
ArcGis que permite fusionar una entidad
segmentada para conformar una sola
unidad.
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INTERSECT
FEATURE

.L*

INPUT COVERAGE

INPUT

L

[ T

INPUT

NS

CLIP COVERAGE

ERASE FEATURE

>

OUTPUT

dh

OUTPUT COVERAGE

OUTPUT

-

OouTPUT

Intersect: Calcula la  interseccién
geométrica de lascoberturas de entrada.
Caracteristicas o  porciones de las
caracteristicas que se superponen en todas
las capas y/o clases de entidad se
escribiran en la clase de entidad de salida.

Clip: Extrae entidades de entrada que se
superponen a las entidades del clip. Utilice
esta herramienta para recortar una parte
de una clase de entidad utilizando una o
mas de las entidades de otra clase de
entidad como molde. Esto es
particularmente 1til para crear una nueva
clase de entidad, también conocida como
area de estudio o drea de interés (AOI),
que contenga un subconjunto geografico de
las entidades de otra clase de entidad

mayor.

Erase: Crea una clase de entidad
mediante la  superposicibon  de las
Entidades de entrada con los poligonos de
las  funciones de borrado. Solamente
aquellas porciones de las Entidades de
entrada que caen fuera de las funciones de
borrado fuera de las fronteras se copian a
la clase de entidad de salida.

Integrate: Es una de las herramientas de
gestion de datos para la manipulacién de
las clases de entidad. Esta herramienta
compara las clases de entidad y hace
idénticos o coincidentes cualquier linea o
vértices que estan a una cierta distancia
unos de otros.



INPUT OuUTPUT

Identify: Es una herramienta de andlisis

utilizado  para realizar andlisis de

> ( \ superposicion en las clases de entidad.

Esta herramienta combina las porciones

IDENTITY de caracteristicas que se superponen la
FEATURE

identidad cuenta para crear una nueva
clase de entidad.

T OUTPUT Update: Es otra de las herramientas de
analisis para realizar superposicion en las

»> clases de entidad. Esta herramienta

: actualiza los atributos y la geometria de

P ETE una clase de entidad de entrada o la capa

FEATURE

de la clase de entidad Update o capas que

se superponen.

2.1.6.- Conversién Vector-Raster.

- ToRaste : .
&5’ ; P Todos los GIS traen herramientas para la conversion
----- ﬁ DEM to Raster raster-vector o viceversa. En ArcMap hay varias formas
----- Feature to Raster
----- A+ Float to Raster convertir datos hacia el formato raster, por ejemplo el
----- Point to Raster . . .
_____ ﬁ Polygon to Raster convertir un archivo de puntos en un raster. Para relaizar
""" #* Polyiine to Raster _ esta tarea se utilizardn las  herramientas de
----- 2 Raster To Other Format (multiple)

geoprocesamiento para la conversion. Las herramientas de
conversion vector a raster se encuentran en ArcTooBox
en Conversion Tools->To Raster, cuyas

herramientas se muestran en la figura adjunta.

Hay un ntimero de herramientas de geoprocesamiento principales que le permiten

convertir datos a raster y desde raster, que se muestran en la tabla siguiente.



Herramienta Descripcion

De ASCII a raster Convierte un archivo ASCII que representa datos raster en un dataset réaster.

De entidad a réaster Convierte las entidades a dataset raster.

De flotante a raster Convierte un archivo de valores de punto flotante binarios que representa datos raster en un dataset
raster.

De punto a raster Convierte las entidades de punto a dataset réster.

Poligono a réaster Convierte las entidades de poligono a dataset réster.

Polilinea a raster Convierte las entidades de polilinea a dataset raster

2.2.7.- Model Builder

ModelBuilder es una aplicacién que se utiliza para crear, editar y administrar
modelos. Los modelos creados, corresponden a diagramas de flujos para trabajos
especificos que encadenan secuencias de herramientas de geoprocesamiento y
suministran la salida de wuna herramienta a otra herramienta como entrada.
ModelBuilder también se puede considerar un lenguaje de programacion visual para
crear ejecuciones de trabajos especificos. La herramienta se encuentra en

Geoprocesamiento -> ModelBuilder, o en el icono e en la barra de menus principal.
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Figura 2.33.- Ejemplo de Model Builder.




2.2.- Analisis raster en SIG

Habiamos discutido del formato raster que es una forma de representar el espacio por
medio de la division del mismo en una matriz de celdillas. ArcMap posee
herramientas para el analisis de este tipo de datos. El modelo de datos Raster es
también conocido como Grid, y ha sido aplicado fundamentalmente al analisis
espacial y Modelado en estudios ambientales y de recursos naturales, sobre todo a
datos de naturaleza continua. Este formato puede ser simple, como es el caso de una
matriz (monobanda), o complejo con multiples matrices (Multibanda) tradicional en

teledeteccion, y como se muestra en la figura siguiente.

Raster Monobanda Raster Multibanda

Figura 2.34.- Formato Raster simple o monobanda y complejo o Multibanda o

Multiespectral.

Podemos clasificar los datos en formato raster desde el punto de vista del pixel, la
estructura(nimero de bandas) y segun su procedencia:

Pixel Continuos
Discretos o Tematicos

Estructura Monobanda
Multibandas
Hiperbandas
Procedencia Iméagenes aéreas y satelitales

Modelos Digitales de Terreno

Calculo Numérico




Las principales caracteristicas de un raster son

a) Valor: Dice referencia al valor almacenado en cada una de las celdas del raster,

esto es, estos valores podran ser ntimeros enteros o reales.

b) Resolucion Espacial: Corresponde al tamano del pixel, pero es la dimension lineal
minima de la unidad mas pequena del espacio geografico que tiene una
representacion explicita en la matriz de datos.

b) Georeferenciacién: La matriz de datos puede estar asociada a coordenadas
geograficas y tener una orientacion en el espacio. La figura 2.35 muestra en forma
esquematica la correspondencia entre coordenadas de mapa y coordenadas de matriz.

Image space Coordinate space

A y' Grid Location (X}

columns

Y

Frows

v

Y Rows 8
Columns 8

a el o aliolnag |+

Cell size .
List of cell values

111122431122243612225466222543662252446625525443544525444444254]

Figura 2.35.- Relacién entre coordenadas de mapa y de matriz en un archivo raster.

Generalmente para definir la posiciéon al interior de un archivo raster, es necesario
conocer las coordenadas de por lo menos dos extremos de la matriz. Segin el sistema
se utiliza la esquina inferior izquierdo como el minimo y la esquina superior derecho
como el maximo, pero también es posible utilizar las otras esquinas para definir las
coordenadas al interior del archivo raster. Los corners son conocidos como Lower
Left, Lower Right, Upper Left y Upper Right. A estas esquinas se les conoce

adicionalmente su posicién en el sistema de coordenadas cartesianas, ademés se



conoce la resolucién del pixel, por lo que es facilmente calculable la posicion de cada

pixel mediante las ecuaciones

X =MinX +(Col+0.5)[ResX (2.4)

Y = MinY +(Fil +0.5)* ResY (2.5)

donde las coordenadas X e Y corresponden al centro de cada pixel celda, Fil y Col
son la Fila y Columna que se desea conocer su posicion, ResX y ResY corrresponden
a la resolucion o tamano del pixel. Los valores MinX, MinY, MaxX, MaxY
corrresponden a las coordenadas de las esquinas superior izquierda y la esquina
inferior derecha de la matriz o capa raster respectivamente. Los valores que
caracterizan espacialmente la matriz pueden almacenarse directamente en una
cabecera de archivo, o en archivo anexo a la matriz de datos. Las ecuaciones 2.4 y
2.5 asumen la convencion de que la primera fila y la primera columna son la fila 0 y
la columna 0. Para la asignacion de las coordenadas la primera columna en una capa
raster es la de la izquierda, mientras que la primera fila serd la superior aumentando
hacia abajo, en sentido contrario al que siguen las coordenadas geograficas y las
representaciones en un modelo vectorial. En el caso contrario, si se conocen las
coordenadas geograficas y se desea conocer las coordenadas de matriz, las ecuaciones
son

Col =int[(X - MinX)/ResX (2.6)
Fil =int[(Y - MinY)/ResY| (2.7)

Los archivos raster son visualizados en la pantalla del computador por medio de
paletas de colores o combinaciones de bandas en el caso de archivos multibandas.

Ademas podemos saber el nimero de orden del pixel por:
n = NCaol [Fil +Col (2.8)

de manera que la primera celdilla es la nimero cero y la tdltima la (NCol*NFil ) — 1,
donde NCol y NFil es el ntimero de columnas y filas totales de una matriz

respectivamente.



El formato raster puede ser aplicado como un modelo del espacio asociado al mundo
real donde es posible asociar cada matriz (Layer Raster) para representar distntas
entidades y variables. En el caso de que una entidad al interior de un archivo raster
no contenga datos y el valor cero es un dato, es posible usar el concepto de valor
nulo o NULL, donde no exista nada. Por ello es fundamental definir este valor y los
programas SIG han definido muchos valores asociados, como por ejemplo -9999 o
NaN(Not a Number) que es nimero muy grande (NaN < Infinito) y es usado
también como un error en los calculos sobre todo cuando hay desbordamiento.

Formato de la matriz

Una matriz puede ser almacenada en el computador (Disco Duro) como un archivo
binario o ASCII, los cuales corresponden al formato basico de almacenamiento de

archivos computacionales.

El formato ASCII (American Standard Code for Information Interchange)
corresponde a un sistema de codificacién que asigna a cada cardcter alfanumérico (A-
Z, a-z, 0-9) o de control (retorno de carro, paso de linea, etc.) un valor entre 0 y 255.
De este forma los textos se almacenaran utilizando un byte por cardcter mas los
correspondientes caracteres de control. En el caso de los niimeros esto es directo ya
que se representan a si mismos. La figura siguiente muestra un archivo ASCII de una
matriz de datos, usada por ArcMap como sistema de importacion y exportacion de
datos, adicionalmente puede contener informacion del valor nulo (NULL) o
nodata__value (-999999).

ncols 13

nrows 12

2llcorner —70.7583339
v1llocorner —-32. 7166661
cell=size 0.00833333076923063

946 B60 819 830 829 892 B59 BZ4 857 925 946 1061 1128
1121 925 800 209 809 811 825 849 934 1074 1172 1075 1168
955 B77 788 792 799 791 B37 B899 943 1047 1041 1002 1090
1036 779 769 775 781 820 832 Be68 837 820 858 954 987

761 753 76l 7ed4 7e0 750 750 755 777 821 Sed4 920 5978

745 734 738 740 743 737 734 F54 800 8988 980 1121 1008
FL7 726 722 730 730 723 727 733 823 901 1184 1329 1401
698 ¥12 709 714 71e 718 728 7e0 911 883 1035 1304 13032
685 688 689 695 814 827 763 810 877 931 1225 1285 1073
669 669 678 684 793 941 1051 995 1052 1021 1002 1069 999
656 660 B89 775 830 839 973 5984 936 879 886 1071 1035
635 649 627 626 751 726 B64 BOT 757 749 807 970 958

Figura 2.37.- Ejemplo de un archivo ASCII de ArcRaster para importacion y
exportacion de datos.



En el caso del formato binario la situaciéon es mas compleja, ya que es posible
almacenar un registro o celda en byte(l byte), integer (2 byte), float (4 bytes) y
double(8 bytes), segiin sea el caso asociado al tipo de registro. A continuacién se
muestra una tabla con la asociacién entre ntumero usado y bytes necesarios para
almacenarlo.

Tipo Almacenamiento
(Bytes)

Boleano 4
Caracter, caracter con o sin signo

Integer sin signo 4
Integer corto sin signo 2
Integer largo con signo 4
Integer largo 8
Float (Real) 4
Float Complex 8
Double 8
Double Complex 16
Long 8
Long Complex 16
Pointer 4
Vector 16

En el modelo raster, el formato binario es la forma mas eficiente de trabajo,
primeramente porque ocupa menos espacio total que si fuera ASCII, y en segundo
lugar porque permite el acceso directo a los datos, esto es el acceso a un pixel
especifico, solamente conociendo su ubicacion en la fila y columna respectiva. Lo
anterior es posible porque todos los registros (pixeles) de un archivo raster tienen el
mismo tamano en bytes. El formato ASCII, por otra parte, solo permite el acceso

secuencial, esto uno a uno, desde el primer al dltimo registro.

El formato matricial binario de ArcInfo es un formato especifico de trabajo del
programa y de uso interno del mismo. Este formato es muy distinto al formato
ASCII Grid de ArcInfo, que como ya lo habiamos discutido anteriormente es un
formato usado para el intercambio entre sistemas. Los archivos se pueden convertir
entre el formato binario y ASCII con los comandos GRIDASCII y ASCIIGRID en
ArcInfo. El formato Grid tiene normalmente asociadas tablas en el directorio de
trabajo, pero también archivos que contienen la definicién de proyeccién en formato
ESRI (prj.adf). Los archivos tienen GRID las siguientes funciones:

dblbnd.adf: Contiene los limites (LLX, LLY, URX, URY).
hdr.adf: Este es el encabezado, y contiene informacién sobre los tamanos de
baldosas, y el nimero de fichas en el conjunto de datos.



sta.adf: Contiene estadisticas, en particular, filas, columnas, minimo, maximo, media

y desviacion estandar.

vat.adf: Es la tabla de atributos de valor asociada al archivo raster.

w001001.adf: Este es el archivo que contiene los datos de la matriz.

w001001x.adf: Este es un archivo que contiene punteros a cada una de los registros

en el archivo raster w001001.adf.

La tabla siguiente muestra varios formatos utilizados para almacenar informacion

raster.

Type Description

BMP Bitmap graphic raster dataset format

GIF Graphic Interchange Format for raster datasets
GRID ESRI's GRID raster dataset format

IMAGINE Image
JP2000

JPEG

PNG

TIFF

GEOTIF
netCDF

ERDAS IMAGINE raster data format

JPEG 2000 raster dataset format

Joint Photographic Experts Group raster dataset format
Portable Network Graphic raster dataset format

Tag Image File Format for raster datasets

Variant enriched with GIS relevant metadata

Network Common Data Form(UCAR)

Despliegue de datos

La pantalla de un computador es un sistema raster, esto es, es un espacio rectangular
dividido en pixeles que pueden tomar distintos colores. Por tanto, para el despliegue
de una capa raster en la pantalla del computador, el programa GIS deberd establecer
una correspondencia entre los valores numéricos de la matriz y el color que mostrara.
Adicionalmente debe realizar un calce geométrico entre el tamano de la matriz y la
pantalla, Si la matriz es mas grande que la pantalla solo se representan en ella
algunos pixeles sino que una proporcion, por ejemplo sélo uno de cada dos, o uno de
cada tres, o uno de da cuatro, o etc....Si la matriz es mas pequena que la pantalla no
se debera hacer remuestreo, sin embargo si es mucho més pequena, debera mostrar
repetidamente un pixel hasta ocupar toda el area visual de la pantalla, motivo por el
cual los pixeles al hacer zoom se ven como cuadrados (La figura 2.2 muestra un

ejemplo de ello).

En cuanto al color a mostrar en pantalla la asignacion se realiza mediante una
funcién lineal, que relaciona los valores de los niveles digitales del archivo raster
monobanda con los colores a asignar, disenados por el usuario, mas conocido como



paleta de color. Una paleta de color corresponde a un archivo que contiene en el
primer campo un numero (ColorMap) y sus respectivos niveles de Rojo(R), Verde
(G) y Azul (B), ver figura 3.38(a). la equivalencia entre nivel digital y color lo
muestra la figura 2.38(b), la cual estd dada por la ecuacién

(2.9)

COLOR:[ 255 J [{ND - MIN)

(MAX = MIN

donde ND, corresponde al nivel digital o valores de los pixeles, MAX y MIN
corresponden al valor maximo y minimo en la matriz de datos sin considerar el

NULL, el cual se despliega como color de fondo, que puede ser negro o blanco.

ColorMap R G B COLOR MAX
0 153 102 255 'Y
51 0 0 255
255
102 0 255 0
153 255 255 0
204 255 102 0
255 255 0 0
(a)
0 ND MIN

MIN ND MAX

(b)

Figura 2.38.- Ejemplo de la correspondencia entre los niveles digitales(ND) de un
archivo raster monobanda y la correspondiente asignacion del color, denominada
paleta de color.

La figura 2.39 muestra a modo de ejemplo un archivo
raster de altitud desplegado en pantalla utilizando un
paleta llamada rainbow(Arcoiris). En el caso de que los
archivos raster sean multibandas, la asignacion del color
se realiza utilizando tres bandas, las cuales pueden ser

elegidas en forma arbitraria por el usuario, segin sean

sus necesidades de analisis.



El color se construye asignando el respectivo R, G y B a con las bandas seleccionadas
y normalizadas para formar el color, recordando que el color se forma con una

proporciéon de cada color primario R, G y B.
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2115
2535
2056
3376
3797
4217
4638
5058
5479
5899
6320
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Figura 2.39.- Ejemplo de un archivo rastef de altitud desplegado en pantalla

il

utilizando un paleta llamada rainbow(Arcoiris).

Fig 63

RGB 4.5.3

Figura 2.40.- Ejemplo de un archivo raster multibanda que corresponde a una
imagen satelital LANDSAT, denominada falso color.



2.2.1.- Estadistica de la imagen

Antes comenzar un andlisis mas exhaustivo de un archivo raster(imagen satelital) es
importante tener una idea descriptiva basica de la misma. Esto se logra con la
obtencién de las estadisticas elementales para sintetizar y describir el archivo
matricial. Entre algunas tenemos valores maximos y minimos, el rango de valores de
una imagen, las medidas de tendencia central media y moda, medidas de dispersion
como la varianza, aplicados a todos los niveles digitales de la matriz. Otro analisis
fundamental es el histograma de la imagen, que nos da cuenta de la distribucion
espacial de los pixeles para hacer algunos procesos en la imagen, que discutiremos
mas adelante en el capitulo de teledeteccién. Ahora haremos un recordatorio de la
estadistica descriptiva.

Media de una distribucién

El valor medio o media de una distribuciéon P se puede interpretar como el valor
esperado de la variable aleatoria x. También se le llama momento de primer orden
respecto al origen y se interpreta como el lugar donde estan concentrados los valores

que toma la variable.

H1o=E(X) =D xF(x) para x discreta.

u = E(x) = jx[f(x) dx para xcontinua (2.10)

—00
Mediana de una distribucién

Para explicar este concepto, consideramos una variable discreta x cuyas
observaciones las hemos puesto en una tabla y las hemos ordenado de menor a
mayor. Llamaremos mediana al valor de la variable que deja por debajo de si al 50
% de las observaciones. Por tanto, si n es el niimero de observaciones, la mediana
corresponderd a la observacion [n/2]4+1. Desde un punto de vista formal sea una x
variable aleatoria y F(x) su funciéon de distribucion acumulada, la mediana

corresponde a la solucién de la ecuaciéon

F(x)=0.5 (2.11)



Moda de una distribucién

La moda en un conjunto de valores aleatorios x se define como el valor de ocurrencia
mas frecuente, de esta forma la moda es el valor que maximiza f(x) y que satisface la

ecuacion

Max, [ f (x)] para x discreta.

2 2.12
ar(x) _ Oy d’f gx) <0 paraxcontinua (2:12)
dx dx

Varianza de una distribucién

La varianza 0? de una distribucién de una variable aleatoria x corresponde al
segundo momento central con respecto a la media. Este momento describe la

variabilidad respecto a la media y se representa por

o? :V(x):E[(x—,u)z}:Z(x—,u)ZEf(x) para x discreta.

5 o 5 _ (2.13)
o’ =V(x) = E[(x—,u) ]: j(x—,u) [F (X) Ceix para x continua

—00

A la raiz cuadrada de la varianza se le llama desviacion estandar y se designa por

o=NX =V’ (2.14)

Coeficiente de variacion de una distribucién

El coeficiente de variaciéon Cv, se interpreta como una medida de la dispersién y se
define como el cuociente entre la desviacion estandar y la media, de acuerdo a

C =

g
P (2.15)

Covarianza

La covarianza Cov, se interpreta como una medida de la dispersién conjunta entre
dos variables aleatorias.



S, =E[(X ~E(X)) Y ~E(Y))]
S,y =%anl(>s -14)(vi - 4) =%le>s O = Ky

(2.16)

Sesgo de una distribucién

El sesgo de una distribuciéon y es interpretado como una medida de la asimetria de

las distribuciones y se puede estimar por

y

3

=@=M (2.17)
g g

Este momento se puede interpretar como
Siy = 0 la distribuciéon es simétrica.

Siy > 0 la distribucién se encuentra sesgada hacia la derecha.

Siy < 0 la distribucién se encuentra sesgada hacia la izquierda.

F
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Figura 2.41.- Ejemplo del efecto de la asimetria para una distribuciéon normal. Su
valor es cero cuando la distribucién es simétrica, positivo cuando existe asimetria
a la derecha y negativo cuando existe asimetria a la izquierda.



Curtosis de una distribucion

La curtosis de una distribucién K es interpretado como una medida de achatamiento

o aplanamiento de la funcién de densidad f(x), y se puede estimar por

Luego este momento es interpretado de acuerdo a

Si K > 3 la distribucién es Leptocurtica
Si K = 3 la distribucién es Mesocurtica
Si K < 3 la distribucién es Platicturtica

N

Leptocurtica Mesocurtica Platicurtica

Figura 2.42.- Ejemplo del efecto de la curtosis para una distribucién normal.

(2.18)

Es posible redefinir la curtosis en términos de la distribucién normal, cuyo valor es 3,

por lo que la definicién 12 la podemos reescribir como

4
K'=K—3=%—3

(2.19)

De forma andaloga a la definicion de K, podemos escribir en relacion a K’ lo siguiente

Si K’ > 0 la distribucién es Leptocurtica
Si K’ =0 la distribucién es Mesoctrtica
Si K’ < 0 la distribucién es Platicturtica



Diagrama de dispersion

Es la representacion grafica mas ttil para describir el comportamiento conjunto de
dos variables o también llamado nube de puntos. En estos graficos cada caso aparece
representado como un punto en el plano definido por las variables denominadas x e
y, normalmente independiente y dependiente.

Y Diagrama de digpersion

X X
Figura 2.43.- Diagrama de dispersion para un conjunto de datos.

Al observar la nube de puntos en el grafico se podra inferir que existe algin grado de
asociacion entre las variables. El grado de asociacion entre las variables se puede
apreciar si los puntos de agrupan en torno a alguna tendencia, por ejemplo algin tipo

de curva.
Correlacion y regresion

Podemos entender la correlacion como una medida que da cuenta del grado de
relacion existente entre dos variables. Lo anterior, a priori, podria implicar que en
este grados de asociacion no importaria cual es la causa y cual es el efecto, o cual
variable depende de la otra. Usualmente para medir el grado de asociaciéon entre
variables se utiliza el coeficiente de correlaciéon de Pearson, mostrado en la ecuacién
14.

IS -m) (v~ 1)

n=
o, o,

(= (2.20)




El coeficiente de correlaciéon varia entre -1 y 1, donde estos valores extremos
representan una correlacion perfecta, en cambio 0 representa ausencia de correlacién.
En la ecuacién 14 n representa al nimero total de datos, 4 al valor medio y O la
desviacion estandar, de cada variable respectivamente x e y. la ecuacién 14 también
puede ser expresada en términos de la covarianza, la cual se muestra en la ecuacion
15.

[ = Cov(x,y)
—UX wy (2.21)

Usualmente suele utilizarse r? llamado coeficiente de determinacion.

La regresién es una técnica estadistica utilizada para modelar la relacién existente
entre dos o mas variables usando para ello ecuaciones matematicas conocidas o
mezclas entre ellas. Por lo tanto el objetivo de este método estadistico es construir
modelos que permitan predecir el comportamiento de una variable dada en funcién
de otras por medio de relaciones funcionales. En las ciencias ambientales el método
de regresiéon ha sido utilizado ampliamente para interpretar y explicar situaciones
reales. Sin embargo, es comun que este método sea mal aplicado, sobre todo cuando
no se realiza una selecciéon adecuada de las variables que van a construir las
ecuaciones de la regresion, o también llamadas variables explicativas o descriptoras.

Para determinar los valores numéricos de los parametros de la funcién tedrica que se
ajustard a los valores de X e Y, se pueden utilizar varios métodos de estimacion,

entre los cuales tenemos

e Gréafico
e Minimos cuadrados
e  Momentos

e Miéxima verosimilitud

Cualquiera sea el método empleado para realizar la estimacién de los pardmetros las

diferencias entre ellos, si estan correctamente aplicados, deberan ser minimas.

Adicionalmente para obtener un modelo de regresion no es suficiente encontrar la
ecuaciéon, porque ademds debemos evaluar que tan adecuado es el modelo de



regresion obtenido. Para esto se usa el coeficiente de determinacion r* conjuntamente

con un test estadistico de bondad del ajuste.

La estadistica descriptiva bésica e histograma puede ser aplicado a una imagen desde
Layer Properties o usando la herramienta de ArcToolBox llamada Spatial

Analyst, como lo muestra la figura siguiente.

"General | Source | Bdert | Display Symbology | Fields | Joins & Relates | Value |
raw raster stretching values along a color ramp Impart.. o o [l (O | 2 | [
- = - Statisi
mn: 3300
Discrete Color Color Value Label /
&7 e e
| mean: 145806
-3a |Lm,.. 2233 std. deviation: 1548.96
ColorRamp: | I - - - Info
I Display Background Value: | o as |- : Input:
[ Usehillshade effect. = [ 1 Display NoDataas |- i
Stretch Count Qut:
Type:  |Histogram Equalize x| Histograms... H i Court In:
™ Invert
) — 4 o |
Aceptar | Cancelar | Adlicar |

Figura 2.44.- Ejemplo del calculo de la estadistica basica de un archivo raster de
altitud o modelo digital de elevacion a partir la herramienta Layer Properties o
Spatial Analyst.

2.2.2.- Reclasificacion

Esta operaciéon matematica es de tipo local y se realiza pixel a pixel, y el proceso
consiste en el reemplazo de las celdas del archivo raster de entrada por nuevos
valores en el archivo raster de salida basandonos en un criterio previamente definido
por el usuario. El procedimiento de analisis se inicia con la agrupacion de los datos
continuos en valores discretos o tematicos de acuerdo a un criterio o regla de
decision. Esta funcién se encuentra en ArcToolBox, Spatial Analyst—
>Reclassify. Antes de aplicar Reclassify es necesario ir a Layer Properties y de ahi
a la pestaiia Symbology donde cambiamos las propiedades de despliegue usando
Classified, solo ahi estamos en condiciones de realizar la clasificaciéon del archivo
raster. El método de clasificacién usado para Classified puede ser ecualquiera de los




métodos estadisticos ahi mencionados en las opciones(intervalos iguales, rupturas
naturales, o especificado por el usuario entre otros). A continuacién se pueden ver los

parametros necesarios para reclasificar un raster en la figura siguiente.

20 21|
General | Source | Bent | Display Symbology | Fields | Joins & Relates |
: q.l
Show: F" Srouping = T Input raster: =
a Reciass field: |value =
Natural Breaks (Jenks)
Discrete Color
Classes: [s 7] Classify... | —Set values to redassify
Bk Old values [ New values | Classfy... |
[ Label | 0-23 1 -
0-23 PEM 7 s |
2300000001 - 65
65.00000001 - 109 65 - 109 3
109.0000001 - 147 109 - 147 4
147.0000001 - 255 147 - 255 5 Acd Elhy
MoData NoData Delete Entries |
I~ show dlass breaks using cel values. DsplayNoDataas |+
I™ Use hilshade effect 1
= i | s | pesen. |
CEa| e [ esa | I Change missing values to NoData
Output raster: | <Temporary> E-'“|

Figura 2.45.- Reclasificacion del raster de alturas en rangos cualesquiera.



2.2.3.- Algebra de imagenes

Una de las herramientas mas ttiles de geoprocesamiento proporcionadas por Spatial
Analyst es la calculadora raster que viene incorporada en dicha extensién. La figura
2.46 muestra la ventana de dialogo de la calculadora raster y se muestra como una
herramienta util y potente para el analisis raster. Esta nos provee de forma facil e
interactiva una serie de funciones que van desde operadores aritméticos, operadores
booleanos y funciones predefinidas. Esta herramienta se sustenta en las operaciones
de algebra de archivos matriciales, definidas como las operaciones algebraicas que se
realizan sobre capas de son aplicables a cada pixel dentro de la capa raster.
Adicionalmente las operaciones podria realizarse también a los pixeles vecinos o a
todo el conjunto de pixeles. La Calculadora raster se divide en las siguientes
secciones:

1. Zona de seleccion de capas raster.
2. Zona de Seleccién de operadores

3. Zona de escritura de la operacién o conjunto de operaciones de algebra de mapas

La ventana de dialogo de la calculadora raster se muestra a continuacion.

Layers:  Arithmetic r— Trigonometric

[ALTZCimg img | | i i

Reclass of ALTZC img _| _| _| il ﬂl Abs it | =n Asin
/ | 4 | 3 | 6 | > | 5= | Or | Ceil | Float Cos | ACos

IsMull

Tan

ATan

e e I

s -5 O W [ e
T oo | ||| o]
Exp2| L092| Squ

E:q;‘lﬂl Log1D| Pow

[

About Building Expressions | Evaluate | Cancel |

Figura 2.46.- Calculadora raster (Raster Calculator) de Spatial Analyst.



2.2.4.- Interpolacion espacial

La interpolacion espacial la podemos definir como un procedimiento matematico que
es utilizado para estimar el valor de una variable o atributo en una localidad
especifica a partir de valores obtenidos de puntos vecinos, ubicados al interior del
area de estudio. La interpolacién normalmente es utilizada partiendo de un nimero
finito de observaciones en terreno, por ejemplo variables derivadas de estudios de
suelos, los cuales posteriormente son transformados a un espacio continuo de forma
de conocer su patrén espacial que sea comparable con as observaciones puntuales de

base en cuanto a su tendencia espacial (Burrough y McDonnell 1998).

La interpolacién es un proceso matematico utilizado para estimar y predecir la
distribucién espacial de una variable a partir de una muestra. Normalmente a la
prediccion del valor se le denomina extrapolacién, debido a que la estimacion de la
variable va mas alla de los limites de la muestra. En esta secciéon se analizaran los

métodos de interpolacién globales y locales.

Interpolaciéon por tendencia.

La forma mé&s conveniente de estimar la distribuciéon espacial de una variable es
mediante el uso de variables auxiliares, que describen satisfactoriamente la variable
de interés. La idea general es encontrar una funcién que de cuenta de la tendencia
espacial de la variable, para ello el método se basa en el uso de regresiones multiples.
Esta puede ser encontrada a partir del método de los minimos cuadrados o por
minimizacién. El caso mas simple es la tendencia espacial de la variable, de tal forma

que esta puede ser representada por
Z(x,y)=Y bx"y° (2.22)
Si usamos variables auxiliares la ecuacion anterior puede ser escrita como

Z(x,y) =3 b, V(%) (2:23)

donde yi (x,y) es una variable auxiliar, y bx es una contante. Esta ecuaciéon muestra
el hecho que una variable puede depender linealmente de otras.



Interpolaciéon con ponderacién con la distancia

Este método se basa en la premisa de que los puntos més préximos a la muestra son
mas parecidos a ella. Ademas a medida que me alejo del punto muestral, menos
parecidos a él son los demas puntos. De tal forma que existe una relacion de
parentesco entre un punto muestral y sus vecinos. Esa relacion de parentesco queda
expresada por una funcién ponderada con la distancia. El valor que tomara un punto
desconocido, pero en la vecindad del punto muestral serd la media ponderada por la
distancia. Matematicamente esto se expresa por la relacion

2. 20 WG ) (2.24)
Z(x,y)=-"

> Wi, j)

donde Z(x,y) es el valor interpolado de un punto no muestreal, z(i,j) es el valor de un
punto muestreal al interior de un radio de busqueda definido, y W(i,j) son los pesos
estadisticos asignados y dados por

. 1 2.25
WQ, ) =—— (2.25)
D, j)

donde D(i,j) corresponde a la distancia euclidiana desde el punto a considerar y un
punto muestreal al interior de la vecindad definida, y n es un exponente. Usualmente

el exponente usado es 2, en la figura 2.47 muestra la funcion W para dos exponentes.

0.8
06 1

041 1/r
02{ 1/

0 2 4 6 8 10 12
r

Figura 2.47.- Funciéon definida como inverso al cuadrado de la distancia para usar
como peso estadistico en la interpolaciéon ponderada por la distancia.



Otro aspecto importante respecto de las funciones de peso W es que es posible

utilizar aquellas que no se indeterminen en el punto, como la funcién Gaussiana o la

Sheppard, entre algunas.

Gaussian Distribution
0.4

e
w

Probability
°
2

o
-

0.0

(-p/s
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Figura 2.48.-
interpolacion.

Kernels alternativos

Shepard's interpolation in 1 dimension: j=2

® ® Samples
/\/ /'\
‘»

-

para usar como funciones W

en la

También es posible utilizar un nimero maximo de vecinos y/o una distancia méxima

para hacer la interpolaciéon, de esta forma podemos asegurarnos que solo los vecinos
mas cercanos tienen un peso significativo en la estimacion (Figura 2.49).

Weight

Cresaman Weighting

Distance from centre

Figura 2.49.- Vecindad utilizada para la interpolacién.



Interpolaciéon segmentaria

Este tipo de interpolacion también es llamada spline, y deriva su nombre de la forma
como se dibujaba una curva, usando un curvigrafo. La idea es usar segmentos
diferentes con ajustes polinomiales diferentes, esto es interpolar diferenciadamente
por segmentos homogéneos. Especificamente es aplicar polinomios de orden inferior a
diferentes subconjuntos de datos. Estos polinomios conectores reciben el nombre de
funciones de interpolacion segmentaria(spline functions). La figura siguiente muestra
el concepto de spline, derivado de las antiguas herramientas de dibujo técnico como
el curvimetro y la cercha, donde se podria generar la curva tedrica que unia los
puntos de forma exacta o con alguna tolerancia asociada a la tendencia de los

puntos.

P4

P1

Tolerance = 0.5

X/\/

Tolerance = 0.2
/ /><\></<

Tolerance = 0.0

Figura 2.50.- Spline, y deriva su nombre de la forma como se dibujaba la curva

tedrica, usando un curvigrafo(Cercha).

Triangulaciéon

Este tipo de interpolacién comienza en la construccion de una red de tridngulos irregulares
(Triangulated Irregular Network TIN). Esto tiene la  peculiaridad de que no se exige
continuidad estadistica de la superficie a estimar. Ademds se puede construir incorporando
una variedad de estructuras auxiliares. Este método se adapta muy bien a la distribucién de
los datos y su densidad. Finalmente conserva los datos que son usados en sus vértices. La

creaciéon de un TIN se compone de dos pasos particulares, la triangulacion propia y la



seleccion de los puntos a usar. En el caso de los SIG, el método mas usado es el de la
triangulacion de Delaunay.

PUNTOS Nodo
e {xlrvlle} ‘:. {xlr\rrlle}
{KB.'VB-'ZB} {KB.'VB-'ZB}
° ol
° Triangulacién e
{KZ-'Y2-'Z2}| {K2N2fz2}|

Figura 2.511.- Esquema de la construccion de una red de tridngulos irregulares a partir de
puntos.

La forma mas simple de construir un TIN es a partir del uso de todos los vértices y nodos de
las curvas o puntos digitales. Pero esto no es tan deseable, en efecto esto genera una enorme
cantidad de elementos y la redundancia debida a la digitalizacion que no hacen un aporte
significativo. Los métodos de triangulacién més utilizados pueden agruparse en las siguientes
clases

a.- Insercién incremental: Comienza con una triangulacion minima y progresiva y selectiva

mente se le van anadiendo nuevos puntos.

b.- Reduccién selectiva : Consiste en la eliminacion de puntos a partir de un modelo masivo

mediante criterios de incremento minimo del error.

La figura 2.51 muestra una representaciéon esquemaéatica de la construcciéon de una red de
triangulos irregulares a partir de puntos, e cambio la figura 2 muestra una triangulacién de
Delaunay realizada a partir de un conjunto de puntos tomados al azar desde un modelo
digital de elevacién.



Fig. 2.52.- Triangulacién de Delaunay de un conjunto de puntos

P3 (X3,Y3,23)

/ li /! / »X

Fig 2.53.- Esquema que muestra la estimacién de un valor al interior de un triangulo.

La interpolacién o la estimacién del valor de Z en el punto P, viene dado por

Z(P)= A [Z,+A,Z,+A,[Z, (2.26)

donde A son pesos que se utilizardn para la interpolacién y que depende de la distancia.



Interpolacion usando poligonos Thiessen de Voronoi

Como vimos en el capitulo de vectores, es un método simple desarrollado para
estimar areas de influencia, sin embargo ademas es usado para realizar interpolacion
entre puntos. En este caso la superposiciéon subyacente que se emplea para establecer
la funcién de interpolacion, consiste en admitir que cada punto no muestral se
parece, mas que a ningin otro, al punto muestral mas proximo. De este modo, la
interpolacion consiste simplemente en asignar a cada punto el valor de la variable del
punto muestral mas préximo a él. Es un procedimiento local ya que se usa un punto
muestral en el calculo de los valores de cada lugar. Los valores iniciales de los puntos
muestrales no son alterados después del proceso de interpolaciéon, de hecho son los
mismos que existian antes. Pues evidentemente el punto muestral mas cercano a uno

del mismo caracter es el mismo.

2.2.5.- Modelos digitales del terreno

Un modelo digital de terreno (MDT) o modelo digital de elevaciéon (MDE o DEM en
inglés) es una representacién matricial o raster de la topografia de un érea de la
tierra. La tabla siguiente muestra las caracteristicas de algunos formatos disponibles
en sitios de Internet

Nombre Resolucion Cobertura geografica Editor Postratamientos
DEM ASTER 30 m La Tierra entera (bajo demanda) NASA No
DEM 1 grado 90 m Estados Unidos USGS Si

DEM 7.5 minutos 10 y 30 m Estados Unidos USGS Si
DEM CDED 23 my 90 m Canada CCOG Si
GTOPO30 30" de arco (~ 1 La Tierra entera USGS/NASA Si
km)
DEM SDTS 10 y 30 m Estados Unidos USGS si
NED 10 y 30 m Estados Unidos USGS si
Visual DEM France* 75 m Francia IGN Si
MNT BD Alti* 50 a 1.000 m Francia IGN Si
Litto3D** 1m Zonas litorales francesas entre -10m y IGN/SHOM Si
+10m
Shuttle Radar 90 m 80% de las tierras emergidas NASA/NIMA No
Topography
Mission|SRTM-3
huttle Radar 30 m Etats-Unis NASA/NIMA No
Topography
Mission|SRTM-1
MOLA MEGDR 463 m Marte (excepto zonas polares)NASA Si
Reference3D 30m 54 millones de km?, 80 millones en 2014 || IGN, Spot Image Si
Nombre Resolucién Cobertura geogréfica Editor Postratamientos




Figura 2.54.- El modelo digital del terreno es una representaciéon numérica de la

superficie.

En la literatura se muestran varios métodos para construir un MDT, pero los

podemos clasificar en:

a) Métodos directos mediante Teledeteccion

Altimetria: Se trata de instrumentos altimétricos montados en aviones o
satélites artificiales orbitando la tierra. La hipotesis basica es que es posible
determinar las diferencias de altitud entre la superficie terrestre y el vehiculo
que transporta el altimetro, y de esta manera estimar las altitudes en
superficie.

Interferometria de imagenes radar: Un sensor radar emite un pulso
electromagnético que rebota en la superficie terrestre, y después el mismo
satélite registra su regreso. Conociendo el tiempo de retardo del pulso y su
velocidad puede estimarse la distancia entre satélite y terreno. En 1999 la
NASA inici6 el proyecto SRTM (http://www2.jpl.nasa.gov/srtm/) para
elaborar un mapa topografico de toda la Tierra a partir de este método.

b) Métodos directos de terreno

Topografia convencional: Mediante el uso de estaciones topograficas en el
campo terreno, se levantan los datos de altura, los cuales posteriormente son

interpolados para construir las curvas de nivel.



* Sistemas de Posicionamiento GPS: Permite estimaciones suficientemente
precisas de latitud, longitud y altitud de un punto, posteriormente deben
interpolarse los datos

Métodos indirectos:

* Restitucion fotogramétrica: Es realizada a partir de fotografia aérea
analogica o digital utilizando la vista terrestre desde dos &ngulos de
observacion.

* Digitalizacion de curvas de nivel: Un mapa ya confeccionado en papel es
convertido en formato digital desde un escaner o una mesa digitalizadora.
Posteriormente se deben interpolar entre las curvas para obtener el MDT.

Los modelos digitales de terreno son construidos a partir de diversos métodos
numéricos de interpolacién de puntos de alturas o curvas de nivel. El método mas

comunmente utilizado es la triangulacion con interpolacién lineal, método

implementado en ArcMap en 3D Analyst.
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Figura 2.55.- Ejemplo de un grupo de curvas de nivel junto a su correspondiente

Ay

triangulacion de Delaunay.

La figura 2.55 muestra un zoom a un archivo de curvas de nivel cada 50 metros del
norte de Chile. A partir de ellas realizaremos la construccién del TIN (Red de



Tridngulos Irregulares o Triangulated Irregular Network), desde 3D Analyst->
Create/Modify TIN-> Create TIN from features..., donde se despliega la
siguiente ventana.

B =% 21
b - - ~Inputs
Create/Modify TIN Create TIN From Features... ™
Check the layer(s) that will be used to create the TIN. Click a layer's name to
Interpolate to Raster b Add Features to TIN... specify its settings.
Surface Analysis 3 Layers:
i .| Settings for selected layer
Redassify... [ curvasso g )
Feature type: 2D lines
Convert »
Height source: Im
Options... Triangulate as: Ihard line 'l

Tag value field: |<None> 'l

Output TIN: | D:\BORRARTAREAS\tin g

Figura 2.56.- Creacién de un TIN a partir de un conjunto de curvas de nivel a partir
de 3D Analyst-> Create/Modify TIN-> Create TIN from features.

La figura siguiente muestra el resultado del TIN, donde se muestra junto a las curvas
de nivel originales. A pesar de su apariencia ain no es un modelo digital de
elevacion, pues ahora hay que convertir el TIN en una matriz de datos continua que
represente a las alturas.

3766.667 - 4183,333
B 3350 - 3766.667
I 2933.333 - 3350
W 2516.667 - 2933.333
B 2100 - 2516.667
B 1683.333 - 2100
1266.667 - 1683.333
850 - 1266.667

Figura 2.57.- Resultado del proceso de creaciéon de TIN.



Para realizar lo anterior es necesario convertir el TIN en un archivo raster, lo que se
realiza mediante 3D Analyst-> Convert-> TIN to raster. La figura siguiente
muestra el resultado de convertir el TIN generado en el ejemplo anterior utilizando la
herramienta TIN to raster, cuyo resultado es un GRID con valores continuos de

alturas o modelo digital de elevacion.

High : 4600
Converts a TIN to a raster of elevation, slope, or aspect.
e [ Fl|  Miow:ss
Attribute: IEevahon j
Z factor: I 1.0000
Cell size: I 526.43 Rows: 243 Columns: 249
Outputraster: | D:\BORRAR\TAREAS \tngrid2 ﬂ

Figura 2.58.- Resultado del proceso de conversiéon de TIN a raster.

A partir del DEM es posible calcular diversas variables derivadas del mismo como
pendientes, exposicion, curvatura, rugosidad, unidades topograficas, iluminacién,
visibilidad y delimitacion de cuencas, entre algunos. La mayoria de los procesos que
describiremos més adelante calculan las tendencias topograficas del pixel utilizando

un kernel de 3x3, o mas si fuese necesario, como lo muestra la figura siguiente.

gEiizeassmansas
recorrido i . .
S

HE RN EE= L

Eif

Raster

Figura 2.59.- Kernel utilizado para estimar variables derivadas del MDT.



Pendiente(Slope): Se define como "el dngulo existente entre el vector normal a la
superficie en ese punto y la vertical'. El calculo es relativamente sencillo, sin
embargo existen diferentes métodos para su estimacion, y todos arrojan resultados
similares pero diferentes. Por ello es importante conocer el algoritmo de calculo que

esta en el SIG que se esta usando.

Degree of slope = & .
rise
; ——=tand
Percent of slope =%*1DD run Fise
A B
g g !
rur

Degree of slope = 30 45 TE
Percent of slope = La 100 373

Figura 2.60.- Ejemplos de calculo de pendiente en grados y porcentaje.

El método utilizado por ArcMap para el calculo de la pendiente es

2 2 (2.27)
slope_degres=57.29578Tan’ (ﬁj e
dx dy

donde los coeficientes cambian el territorio, pues dependen de las variaciones locales

de la altura.

o] (%j_[(c+2f+i)-(a+2d+g)] (2.28)
dx ) 81X cellsie

R % :[(g+2h +i)-(a+2b+c)]
dy 8Ly_cellsize




0 - 1.016428869

I 1.01642887 - 2.202262549
[ 2.20226255 - 3.38809623
[13.338096231 - 4.658632316
[[]4.658632317 - 6,013870808
[ 6.013870809 - 7.538514111
I 7.538514112 - 9.486663443
I 5.486669444 - 12.11244402
I 12.11244403 - 21.59911346

Figura 2.61.- Pendiente del terreno calculada en grados.

Exposicién(Aspect): Este pardmetro también se llama orientacién del terreno, que
es el dngulo medido en la direccién horaria desde el norte (acimut) donde se produce
la maxima pendiente. Al igual que la pendiente, esta puede ser calculada a partir del
MDT utilizando los 8 vecinos que rodean a la celda en la que se desea realizar el

calculo. El algoritmo implementado en ArcMap es el siguiente

aspect 57.29578atan EE} (2.29)
dy dx
donde

mctan(g) >0
arctan (£) + y>0,x<0

atan2(y, r) = a.rctan(ﬂ) -n y <0,z <0
+3 y>0,x=0
-3 y<0,a=0
undefined y=0z=0

Para el calculo final debe tomarse en cuenta que

if aspect < 0 then
cell = 90.0 - aspect
else if aspect > 90.0 then
cell = 360.0 - aspect 4+ 90.0
else
cell = 90.0 - aspect
end if



Notese que para una superficie plana la

315 45

exposicion toma el valor de -1 (Color
gris), donde el resto de los valores se le
asigna un color dado por la figura

adjunta.

[ Flat (-1)

I North (0-22.5)

[ Northeast (22.5-67.5)
[JEast (67.5-112.5)

I Southeast (112.5-157.5)
[ south (157.5-202.5)

I southwest (202.5-247.5)
I west (247.5-292.5)

I Nor thwest (292.5-337.5)
I North (337.5-360)

Figura 2.62.- Exposicién del terreno calculada en grados respecto al norte (0°).

Curvatura: Corresponde al valor de la segunda
derivada de la superficie celda a celda. La figura

adjunta muestra un esquema del procedimiento de
cdlculo de la curvatuta, basado en un plano de 22\
tendencia. Para el célculo en cada celda se realiza I A
una transformacién polinémica de cuarto orden de la 75 z
forma: i
z8
O O
Z=Ax2y2+Bx2y +Cxy2+Dx2 +Ey2+ Fxy+Gx + Hy + | (2.30)

donde los coeficientes A, B, C, D, E, F, G, H e I, son calculados por



T [(Zl+23+z7+ Z9)  (Z2+Z4+Z6+78) +z5} (2.31)
4 2
d | e | f A=

L4
g | n| o [ (Z1+23-27-29) (z2-78) }
B= 4 2
L3
[(-21 +73-77+29) , (Z4- 26)}
c= 4 2
L3
(z4+26) 25}

p=t 2

L2

(22+28) 25}

=l 2

L2
e [ -z1+23+27-29

4L2
G= (-Z4+ Z6)

2L
o (22-28)
2L
=275
Finalmente la curvatura se estima por
Curvature=-200( (D +E) (2.32)

La herramienta se encuentra en ArcToolBox, Spatial Analyst Tools->
Surface-> Curvature.

La curvatura puede interpretarse de acuerdo a la siguiente regla:

* curvatura > 0.2, superficie convexa.
e curvatura entre -0.2 y 0.2, superficie plana.
* curvatura < -0.2, superficie concava.

Una vez que la curvatura es reclasificada es conveniente homogeneizar los resultados
aplicando un filtro de mayoria.

La figura 2.63 muestra una visualizacion de la curvatura, donde la idea es utilizar
esta cobertura calculada para describir las caracteristicas fisicas de una cuenca de
drenaje para explicar los procesos de erosién y escorrentia. Tedricamente la curvatura

del perfil afecta la aceleracion y desaceleracion del flujo superficial lo que puede



influir en la erosién y la sedimentacion. La curvatura de la superficie se

entonces con los conceptos de convergencia y divergencia del flujo.

P High : 0.156355

il Low : -0.096158

Unidades Topograficas: Estas corresponden realmente a

Figura 2.63.- Curvatura del terreno.

relaciona

una clasificacion de las

formas del relieve. Esta puede ser estimada a partir de los diferentes parametros

estudiados anteriormente, como la pendiente, exposicién u orientaciéon y curvatura.

Todas estas nuevas capas de informacién se unen al modelo digital del terreno para

realizar esta clasificacion. De esta forma cada celda de la matriz altitud, tiene,

ademas, asociado estos valores adicionales que la caracterizan desde un punto de

vista geométrico, pero a partir del cual es posible definir unidades de pseudo paisaje.

Una aspecto importante es que todas las variables auxiliares calculadas a partir den

MDT poseen una fuerte dependencia de la resolucién. La tabla siguiente muestra una

descripcion de los elementos de una caracterizaciéon morfométrica del terreno.

Elemento

Descripcion

Punta

Convexo en todas las direcciones

Cresta

Convexo en una direccién ortogonal a una linea sin curvatura.

Collado

Convexo en una direccién ortogonal a una zona concava.

Ladera

Pendiente sin concavidad.

Plano

Pendiente nula y sin curvatura.

Canal

Céncavo en una direccién ortogonal a una linea sin curvatura

Sumidero

Concavo en todas direcciones.




La definiciéon anterior es posible hacerla operativa en una clasificaciéon del MDT a
partir de sus propiedades derivadas (pendiente, exposicién u orientaciéon 'y
curvatura). La siguiente tabla es una recomendaciéon para la caracterizacion de la

morfometia superficial (Wood, 1996).

Forma Pendiente | Curvatura Conviax | Convimin
Punta 0 # + +
Cresta 0 # + 0
+ + # #
Collado 0 # + -
Ladera + 0 # #
Plano 0 # 0 0
+ 0 # #
Canal 0 - # #
+ # - -
Sumidero 0 # # #
+ - # #

El esquema de clasificacién propuesto por Wood se encuentra basado en 6 formas
tipo que se caracterizan, de un modo semicuantitativo, de acuerdo a lo mostrado en

la tabla anterior:

+ significa mayor que 0
- significa menor que 0
# indiferente

Sin embargo es muy necesario definir los umbrales para cada variable a clasificar. El
calculo se realiza a partir de un kernel o ventana espacial de tamano adaptativo.

Los MDT y sus propiedades derivadas (pendiente, exposicion u orientacién y
curvatura) son variables o factores de gran importancia en la aplicacién un ntimero
significativo de procesos ambientales (Temperatura, Precipitacién, Radiacién solar,
Hidrologia superficial, erosion, modelacion de nicho y habitat, etc.). Por ello es
posible utilizar el MDT y sus propiedades derivadas como variable independiente

para estimar otras variables mediante procedimientos de regresion global o local.
Iluminacién:

Crea un raster de iluminacion o de relieve sombreado a partir del MDT utilizando
para su céalculo el angulo de la fuente de iluminacion, con ello genera las respectivas
sombras. Esta herramienta genera entonces la iluminacion hipotética de una

superficie estimando los valores de iluminacién para cada pixel del MDT usado. La



forma de proceder es configurando la posicién de una fuente de luz (Sol) y con este
dato se calculan los valores de iluminacion de cada pixel respecto de las celdas
vecinas. Esta cobertura de iluminaciéon mejora la visualizaciéon de una superficie y
mejora el analisis producto de esta visualizacion grafica. Por defecto, la distribucion
espacial de la iluminacién (Luz y sombra) se representa con tonalidades de grises

asociados a nimeros enteros que van de 0 a 255 (aumenta de negro a blanco).

El célculo de la iluminacion se realiza conociendo la geometria solar, que son el

acimut y la elevacion solar, que se describen a continuacién.
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Acimut: "Es la direccién angular del sol, | Elevacién Solar: "La elevacion solar es
medida de 0 a 360 grados desde el Norte | el angulo de la fuente de iluminaciéon por
en sentido de las agujas del reloj. Un | encima del horizonte. Las unidades se
acimut de 90° es Este. El acimut | expresan en grados, de 0 (en el
predeterminado es 315° (NO)". horizonte) a 90 (arriba). El wvalor
predeterminado es 45 grados'.

El algoritmo de célculo es

Hillshade= 255[{A +B) (2.33)
A =Cos(Zenithrad)Cos(Sloperad)
B =Sin(Zenith rad)tSin(Sloperad)[Cos(Azimuh_rad- Aspect_rap

donde Slope es la pendiente, Aspect es la exposicion, en ambos casos del
correspondiente pixel donde se esta realizando el célculo, ambos deben ingresarse en

radianes a la ecuacién 2.33.

ArcMap asigna el valor 0 a la iluminacién de salida si el calculo de ecuacién 2.33 da
valores negativos. El angulo cenital en grados es



Zenith_deg=90- Altitude (@) (2.34)

donde la elevacién solar (Altitude) o se calcula a partir de
Sin(a) = Sin(A)Sin(8) + Cos(A) os(6) [os(h,) (2.35)

donde A es la latitud del pixel, & es la declinacién solar en el dia que se esta
calculando la iluminacién y hs es el angulo horario, que depende de la hora del dia.

h, =15[12~hord| (2.36)

donde la hora corresponde al tiempo de reloj para un dia de 24 horas, desde la hora
de la salida del sol hasta la puesta del sol. El sol avanza aproximadamente del orden
de 15°/hora durante el dia, por lo cual de esta forma es posible estimar el angulo
horarion a una determinada hora del dia. Hay que tener en cuenta que si Azimuth
>= 360, entonces, Azimuth = Azimuth - 360.
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Figura 2.64.- Recorrido del sol durante un dia que complet 180 ° en 12 horas

aproximadamente, barriendo a una velocidad media de 15 °/hora.
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Figura 2.65.- Hluminaciéon de una superficie por medio de un algoritmo numérico
llamado Hillshade(Spatial Analyst Tools-> Surface-> Hillshade).

Visibilidad:

El célculo de la visibilidad es conceptualizado como el area que un observador puede
ver en todas direcciones desde un punto especifico al interior de un MDT. Esta
herramienta resulta de utilidad para el diseno de variadas redes, por ejemplo para la
instalaciéon de torres de monitoreo de incendios forestales, o para la ubicacion de
rellenos sanitarios al interior de un territorio. El algoritmo de célculo parte de la base
que dos puntos seran mutuamente visibles si la linea recta que los une no tiene
obstaculos, esto es la altitud del terreno se encuentra bajo la cota de altitud de la

linea de observacion.
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Figura 2.66.- Visibilidad desde un punto sobre un MDT y cunca visual.



Asociado la visibilidad se encuentra el concepto de cuenca visual desde un punto
base ubicado sobre un MDT, que se encuentra definida como el conjunto de puntos
sobre el MDT que son visibles por un observador ubicado en dicho punto base.

Por ejemplo este concepto resulta muy 1util al momento de definir sitios de
observacion asociados a areas de interés turistico. Otro aspecto para un posible uso
es una posible la evaluacion del impacto visual de intervenciones en el territorio y
que potencialmente puedan tener efectos negativos sobre el paisaje. En general, un
modelo de este tipo puede servir para la toma de decisiones, ya que es un calculo
objetivo y confiable, pero ademas le permite al usuario conocer y comparar diferentes
alternativas sobre la incidencia visual de una intervencion en el territorio.

Para aplicar esta herramienta hay que ir a ArcToolBox->Spatial Analyst
Tools-> Surface-> Viewshade o usar la extension 3D Analyst-> Surface
Analyst-> Viewshade.
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Figura 2.67.- Célculo de la cuenca visual utilizando la herramienta Viewshed.

Delimitacién de cuencas:

Una cuenca hidrogréafica la podemos definir como un espacio dentro del territorio
cuya delimitacion estd condicionada por la linea divisoria de las aguas. Internamente

la cuenca corresponde a una red o sistema hidrico que conducen sus aguas a un cauce



principal. La cuenca es en si un ente tridimensional, que integra las interacciones

entre el uso del suelo, la litologia y su singularidad topografica.

é; Hydrology
----- #* Basin
..... }& Fill

----- A Flow Accumulation
----- A Flow Direction

----- A Flow Length

..... }& Sink

----- A Snap Pour Paint
----- A Stream Link

----- A Stream Order

----- Stream to Feature
g Watershed

ArcMap trae herramientas para estudios hidrolégicos, que queda
ArcToolBox->Spatial Tools->
Hydrology. Todas estas herramientas son de bastante utilidad

ubicada en Analyst
en estudios ambientales. Entre los célculos que puede realizar
estan el flujo, tanto en direccion como en acumulacion,
delimitacion del area de la cuenca, entre algunas. Para delimitar
las cuencas es necesario calcular primeramente la direccion del

flujo superficial.

Las figuras 2.68 y 2.69 muestran las ventanas en ArcMap para Flow Direction y

Basin, ambos en ArcToolBox->Spatial Analyst Tools-> Hydrology.

* Flow Direction

Input surface rastsr

=10l|

[kingrid
Output fiow direction raster

;Iﬂ‘

| D:\BORRAR TAREAS \FlowDIr _ting2
I™ Force all edge cells ta flow outward {optional}
Output drop raster (optional)

=

o]

Environments. ..

=]

I]

Show Help >> |

& Input flow direction raster

4 Output raster

Figura 2.69.- Delimitacion de las cuencas hidrograficas en un territorio.



2.2.6.- Conversion Raster-Vector

Como en el capitulo de molo vectorial revisamos la transformacion vector->raster,
también es posble la ruta opuesta raster->vector. El procedimiento de conversion de
un raster a vector y viceversa se encuentra en la extension Spatial Analyst ->
Convert -> Raster To Features o Features To Raster.

ﬂ Raster to Features 2 x]
|Spatial Analyst | Layer: [CUENCAS img = B
. =
B == > Input raster: [cuenicas.img =] Dl
Density.
Interpolate to Raster » Field: |<Value> j
Surface Analysi »
= Output geometry type: IPongon ﬂ
Cell Satistics. ..
Neighborhood Statistics. .. [ Generalize l
Zonal Statistics...
Zonal Histogram ... Output features: IC:\JJsers‘J.MSWQDam\Lo:BIT |j"|
Redassify.

Figura 2.70.- Método para aplicar la conversion raster vector en Spatial Analyst.

Para la conversion Raster to Features debemos tener presente que esta conversion
sera posible si el archivo raster a convertir es de tipo discreto o tematico. No es
viable aplicar esta herramienta a archivos raster continuos, sin embargo si se clasifica
sera posible aplicar la conversiéon. Hay que notar que ArcMap aplicara un algoritmo
se suavizamiento de los limites de las cuencas para darle una apariencia mas estética.

8

Figura 2.71.- Conversién de cuencas en formato raster a vectorial.




